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Overview

Overview

RMTrak is a requirements management tool, developed by Prometeo Technologies. RMTrak was designed to be
used by product development companies but can easily be configured for any other type of company needing to
tag, trace, allocate, and verify project requirements.

Requirements Management Tools

Product development companies frequently contend with requirements management: Clients, developers, and
industry standards determine the many requirements necessary to complete a project. The product development
company then needs to keep track of each requirement, as well as when and how it was successfully
implemented and tested. Since large projects can have thousands of requirements, this is often a difficult and
tedious task. Requirement management tools provide a means of tracking your project's requirements.

RMTrak is a requirements management tool designed for beginner and advanced users alike; it allows you to
manage your development project's requirements and generate different kinds of views and reports, depending on
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your needs. It also allows you keep track of whether your requirements passed or failed required tests.

Unlike other requirements management tools, RMTrak was designed with two primary features in mind: allowing
its users to create their documents as they usually do while adjusting to their needs, and to keep important
information in the documents themselves. Rather than require you to tag or create documents that conform to a
standard, RMTrak is flexible and allows you to configure your RMTrak project to match the information you will be
using. The main difference is that your documents will now include tags - the purpose of which is to mark the most
important information within the documents. Because all of the relevant information is stored in the documents,
you will never have to worry about a database becoming corrupt or about losing your RMTrak database files.
Recreating an RMTrak database is simple because it gets its information directly from your documents.

The tags you add to your documents are easy to create and, unlike other requirements management tools, RMTrak
does not force you to make them a certain way: Although the tutorials, samples, and online help files offer
suggestions, there are limitless different ways to format your tags because RMTrak is highly configurable.

How It Works

RMTrak works using your companies' existing product development documentation (created in Microsoft Word)
with one adjustment: adding tags around each requirement listed in your documentation will later allow RMTrak to
recognize these items as traceable requirements. Because you can put tags in any chosen Microsoft Word style,
you can easily make these tags invisible to non-technical readers.

After you create documents with tagged requirements, you import them into RMTrak, which will load the
requirements into a database from which you can generate reports and views based on the tags and their
attributes. For example, you can generate reports based on which items successfully passed their tests and which
requirements have been fulfilled for the project. As you continue to maintain the documents using Microsoft Word
and to manage their requirements using RMTrak, you will continue to get a comprehensive picture of the state of
all requirements and how your project is progressing.

Benefits

Use What You Know

Too often, adopting new tools forces you to adopt new technologies, processes, and perhaps even supporting
tools. RMTrak works with the tools you already have. If you can use Microsoft Word, then you can use RMTrak.
Requirements are pulled directly from the documents and placed into the project's database. When a requirement
changes, the database can be refreshed with the click of a button.

Do Not Lock Yourself In

Many database-centric tools force you to store your documents in a central location which, consequently, forces
clumsy, awkward and time-consuming procedures to be adopted in order to access those documents. With
RMTrak, the database is secondary to the documents. Also, since all relevant information is stored in the
documents, if the database is ever lost, it is a simple matter to rebuild it.

Manage Your Projects

According to the Standish Group, over 80 percent of projects are challenged or fail. RMTrak provides you the ability
to monitor changes to requirements, view the requirements as a whole (even when distributed among many
documents), and easily determine the Test Pass status of any requirement in the system. Software developers,
systems engineers, project managers, or anyone who requires a quick report on the status of project
requirements can use RMTrak.

System Requirements

An executive or administrator who may only need to use RMTrak to print reports or save views, can utilize these
features easily without having played a role in the creation of the requirements documents. The online help system
and the RMTrak Getting Started tutorial will serve as a guide. The RMTrak Getting Started tutorial is available from
the RMTrak folder of the Start menu.

The developer or project management team creating the database and documents to be used with RMTrak, will
need to know the following:
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How to use Microsoft Word for creating your documents. The Tips for Using Microsoft Word topic gives an overview
of some particularly useful features that will help you get the most out of the documents you import into RMTrak.

Although RMTrak can be used to manage requirements for any type of project, it was especially designed for
product development companies. Familiarity with product development and a defined product development
process will be beneficial.

Licensing

RMTrak uses a concurrent licensing model. This model allows you to install the application on more computers
than you have licenses as long as you can guarantee that the two copies will not be used concurrently. For
example, John has RMTrak installed on his work computer. There are times when he works from home. As long
as no one else uses John's computer in his absence, it is legal for John to install RMTrak on his home computer.

License Manager

RMTrak requires a key to activate it. You can activate RMTrak with an Evaluation Key (sent to those evaluating
RMTrak for 30 days) or an Application Key (provided to those who have purchased RMTrak).

Note: An Evaluation Key will cease to work after 30 days.

You can obtain keys through the RMTrak Web site: http://www.RMTrak.com. After completing the Evaluation form or
Purchase form (available on the Web site), Prometeo Technologies will send you either an Evaluation Key or an
Application Key via E-mail. You can then activate RMTrak:

1. Open the E-mail and download the included Key to your computer.

2. From the Start Menu, select Programs, select RMTrak, and then click License Dialog.

3. Use the License Dialog to find and install the downloaded Key. Once the Key is installed, you will be
ready to use RMTrak.

Sample Databases

RMTrak provides sample files and databases which can be used to learn effectively utilize RMTrak's many
features. These files use the fictitious project Revolutionary Automated Teller Machine (RATM). The files can be
found in the <Installation Directory>\\Sample directory. If RMTrak was installed in the default location then
<Installation Diorectory> will be C:\Program Files\RBC\RMTrak for 32-bit systems and C:\Program FIles (x86)\RBC
\RMtrak for 64-bit systems.

Uninstall

To uninstall RMTrak use the Add/Remove feature in the Microsoft Windows Control Panel or use the Uninstall
Menu on the RMTrak Start Menu. If using the Control Panel, from the desktop, double-click the My Computer icon.
Double-click the Control Panel icon, then double-click the Add/Remove Programs icon. Find RMTrak in the list
then click Add/Remove. If using the Uninstall Menu, click the Start Button, Click RMTrak, and then click Uninstall.

Contact Us

Prometeo Technologies is dedicated to making you a successful, satisfied customer. If you have any questions,
comments, or suggestions regarding RMTrak, please do not hesitate to contact us:

sales@RMTrak.com (general inquiries)

support@RMTrak.com (support)

Additionally, please check the RMTrak web site, www.rmtrak.com for updates or additions to RMTrak, help files,
and tutorial.

Concepts

mailto:sales@rmtrak.com
mailto:support@rmtrak.com
https://www.rmtrak.com
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Tagging

RMTrak works with your companies' product development documentation with one adjustment: adding tags
around each requirement listed in your documentation. These tags will allow RMTrak to recognize these items as
traceable requirements. Because you can put tags in any Microsoft Word style, you can easily make these tags
conform to your existing documentation style.

What Are Tags?

Tags are text that you place in your documents to allow RMTrak to identify requirements and their attributes. Tags
come in three varieties, Child Tags, Parent Tags, and Attributes. A Child Tag is used to uniquely identify any
requirement. A Parent Tag is used to create a link between two requirements. An Attribute is used to specify
information about a requirement. Tags can be identified by being red/bold text or by being a specific Microsoft Word
Style.

In the following example, the tags are in bold/red text and the requirement text is in non-bold black text.

RATM:VTR:1 Verify that the circuit shall be interrupted when the ground is shorted. 
{Test Pass = T} {Test Date = 11/01/01} {Test Method = D} {Tester = QA} [RATM:PRD:1]¶

Why Your Documents Need Tags

From the tags around the requirement, RMTrak can identify the requirements, identify links between the
requirements, and learn information about your requirements. Using the example above, RMTrak is able to
determine the following information:

o The requirement will be identified as RATM:VTR:1.

o The requirement is derived from the requirement RATM:PRD:1 (as noted by the [RATM:PRD:1] tag).

o The requirement is a test and it has passed (as noted by the {Test Pass = T} attribute).

o The test was run on 11/01/2001 (as noted by the {Test Date = 11/01/01} attribute)

o The test is a Demonstration. (as noted by the {Test Method = D} attribute)

o The test was run by the Quality Assurance (QA) department (as noted by the {Tester = QA} attribute)

A few simple tags provide a lot of information about a requirement and enable RMTrak to trace the complex
relationships between requirements.

How to Tag Requirements

Child Tags can be placed in your document in one of three ways.

The first method is to manually insert the Tags in to the document. The easiest way to do this is to paste the
appropriate Tag Format with a numeric portion of 1 before each requirement and then use the Tag Renumber
macro  to order the tags and make them unique.

The second method is to use the Insert Tag Macro. This macro brings up a dialog box and places the tag at the
current cursor location. Each time a tag is inserted the number is incremented.

The third method is to use the Auto Tag macro.

 

Parent-Child Relationships

Tag Identification

Tag Syntax

Carriage Returns

Requirement Identification

tag_identification.htm
tag_syntax.htm
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Terminal Requirements and Documents

Attributes

Closure Report

Child Tags

A Child Tag uniquely identifies a requirement. To be valid a Child Tag must have the following properties.

o Must only contain letters, numbers, colons, underscores, and periods.

o Must be unique within a document.

o Must be unique within a project.

To make Child Tags easily recognizable, you may want to establish a naming convention. The convention
recommended is DOCUMENT:NUMBER. For example,

PRD:12

SRS:33.1

Following this convention allows a reader to identify the document containing the requirement just from the Child
Tag. In cases where there are multiple instances of a document type, another mnemonic can be added between
the document and the number. For example, if there was an SRS for the User Interface and another for Control
then the following Child Tags could be used.

SRS:UI:13

SRS:CTL:15

If the document is going to be used in multiple projects, then you might want to consider appending a project
name to the front of each Child Tag.

RATM:PRD:1

RATMN:PRD:2

RATMW:PRD:2

By including a unique project name, groups of requirements can be kept out of the project by using the Tag Filter.

 

Tag Identification

Tag Filter

Parent Tags

Parent Tags are used to establish a link between two requirements where the child requirement is derived from or
necessitated by a pre-existing parent requirement. In an unfortunate name choice by the software industry, a
requirement that does not have a parent is called a Derived Requirement, because the requirement is "derived"
from the design. Consequently, the requirement which contains the Parent Tag is in actuality a Child Requirement
which was derived from another requirement rather than having been derived from the design. It is important to be
clear on this in order to ensure that the parent tag gets placed on the correct requirement. One benefit to this
approach for regulated organizations (that often require that released documents be locked down and remain
unchanged) is that the Parent Tag linking the requirements back to the requirement from which they originated can
be placed with those subsequent requirements in a new document thus linking them back to the originating
requirement in the released document without violating lock down.

A Parent Tag contains the unique Child Tag that identifies the parent requirement enclosed in brackets. For
example if SRS:1 is derived from PRD:1 then the following syntax would be used.

terminal_req_and_doc.htm
tag_identification.htm
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SRS:1 The software shall display the version at startup. [PRD:1]

A child may have multiple parent tags. For example,

PRD:1 The product shall have a green start button.

PRD:3 All buttons shall be large enough that a person wearing ski gloves can operate them without interfering
with other buttons.

ERS:10 The start button shall be a green circular button with a one inch radius. [PRD:1] [PRD:3]

A Parent Tag can contain multiple Child Tags separated by commas. In the previous example, ERS:10 could be
written as follows.

ERS:10 The start button shall be a green circular button with a one inch radius. [PRD:1, PRD:3]

 

Tag Identification

Document Hierarchy

Parent-Child Relationships

Attributes

Attributes are used to convey information about a requirement. RMTrak loads this information into the database
and allows you to query, sort, and filter upon the values. The generic syntax of an Attribute Tag is {Name=Value}.
Where Name is the name of the attribute and Value is its value. By adding attributes to your requirements, you can
trace requirements' information, such as test pass status, author, priority, etc.

RMTrak's default attributes include attributes common to product development. These default attributes can be
added to, edited, or deleted at any time using the Attributes Dialog available from the Setup menu. If your company
wants to add attributes such as risk, cost, importance, etc., RMTrak lets you do this easily.

Default Attributes

Name Type Rule Description

Implementer Enum
(Multiple)

HW;SW;QA This attribute can be used to show that the requirement's
implementer is one or more of the Hardware, Software, and/or
Quality Assurance groups within the company. This attribute is
especially helpful for tags within Software Requirement
Specifications. If your organization has other groups, then the rule
associated with this attribute can be modified.

Test Date Date   This attribute can be used to show the requirement's test date.
This attribute is especially helpful for tags within test requirement
documentation.

Test Method Enum
(Single)

I;A;D;T This attribute can be used to show that the requirement's test
method is either Inspection, Analysis, Detection, or Test, which are
common product development test methods. This attribute is
especially helpful for tags within test requirement documentation.
To avoid repetitive typing, these values have been given acronyms.

Test Pass Boolean   This attribute can be used to show the result of the requirement
having been tested. The result can either be T (for True/Passed) or
F (for False/Failed). RMTrak marks passed requirements as
"closed" for its reports and views. This attribute is especially
helpful for tags within test requirement documentation.

Tester Enum
(Single)

HW;SW;QA This attribute can be used to show that the requirement's tester is
either the Hardware, Software, or Quality Assurance groups within
the company. This attribute is especially helpful for tags within test
requirement documentation.

None of RMTrak's default attribute types are Persistent.

tag_identification.htm
attributes_dialog.htm
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For information about applying these attributes to your tags, please see the Attributes' Data Types and Rules
Syntax and Overview of Tagging topics.

System Attributes

In addition to User-Defined attributes, RMTrak has several System Attributes that can be used in views and filters.
System Attributes are things that RMTrak can figure out about your requirements without you needing to specify it.
The following are the System Attributes.

Name Type Rule Description

Childless Boolean   This value is TRUE if a requirement has no children and is not in a
terminal document.

Suspect Boolean   This value is TRUE if a requirement's parent has changed since
the requirement was last updated.

Orphan Boolean   This value is TRUE if a requirement has no parent in the database.

Text String   This value is requirement text extracted from the document.

Document N/A   This value is document containing the requirement.

Document Type N/A   This value is the document type containing the requirement.

 

Defining Attributes

Attributes' Data Types and Rules Syntax

Overview of Tagging

Attributes' Data Types and Rules Syntax

RMTrak currently supports six data types: Unknown, Integer, Float, Enum (Single), Enum (Multiple), Date, String,
and Boolean. Some data types require a rule, which you can create. The rule you create will need to use a specific
syntax so RMTrak can understand the rule you are creating. A data type limits the values that can be assigned to
the attribute, such as whether it will be numbers, characters, etc. The rule syntax specifies all of the possible
values you could give to the requirement, and limits the requirement's attributes to this list.

Tip: If you are unsure which data type to choose, choose String.

The following table defines the attribute data types and their corresponding syntax for creating rules, and then
shows examples of the kinds of rules you can create. (Areas in this table marked by a dash [-] represent data types
that do not need rules.)

Data Type Rule Syntax Example
Rule

Example of Attribute Using
the Rule

Unknown - - -

Integer Attributes with this attribute type must
be whole number integers.

- {SerialNumber = 1632956}

Float Attributes with this attribute type must
be real numbers with up to two places
to the right of the decimal.

- {PartNo = 15.9}

Enum
(Single)

Attributes with this attribute type can
be any one item provided within the
rule. The rule should be a semicolon-
separated list of values. The
maximum rule length is 255
characters.

I;A;D;T {Test Method = A}

Enum
(Multiple)

Attributes with this attribute type can
be one or more items provided within
the rule. In this example, one or more
of the Hardware, Software, and/or

HW;SW;QA;
MECH

{Implementer = HW;MECH}

attrib_definition.htm
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Quality Assurance divisions within the
company. The rule should be a
semicolon-separated list of values.
The maximum rule length is 255
characters.

Date Attributes with this attribute type must
be a date.

- {Test Date = 10/31/2001}

String Alphanumeric (letters and numbers)
string with a maximum of 50
characters.

- {Model = 14B8728}

Boolean Attributes with this attribute type must
be true or false. The legal values for
this attribute are "T", "TRUE", "F", or
"FALSE".

- {Test Pass = T}

Tip: To save repetitive typing in your documents, use acronyms instead of words for values everyone understands.

Examples:
Too lengthy:
Rule: Hardware;Software;Quality Assurance; Mechanical
Example of attribute: {Implementer = Hardware;Mechanical}

Much better:
Rule: HW;SW;QA;MECH
Example of attribute: {Implementer = HW;MECH}

Requirement Identification

When you import a document, RMTrak begins scanning the document for a  tag, which will be text that matches the
established Tags Setup by being either red and bold or a Microsoft Word style.

In the following example, RMTrak would notice RATM:VTR:1 because it is bold and red (if RMTrak has been set up
to recognize bold/red tags).

RATM:VTR:1 The circuit shall be interrupted when the ground is shorted. 
{Test Method = I}
[RATM:PRD:1]¶

Once it has found the defining tag, RATM:VTR:1, RMTrak looks for the requirement text after it. To RMTrak,
requirement text starts immediately after the defining tag and continues until the terminating information is found.
Terminating information can be either paragraph mark (¶) or a special character/symbol of your choice, depending
on how you have configured RMTrak's Requirements Setup. In this example, RMTrak is set up only to recognize
paragraph marks.

Because RMTrak has not yet come across the terminator, when is sees the next bold/red tags, RMTrak knows to
look at their syntax (curly brackets and brackets) to recognize that these items are the attribute, {Test Method = I},
and the parent tag, [RATM:PRD:1].

When RMTrak finally comes across the terminator, ¶, it knows the tags for this requirement have ended. RMTrak
then begins looking for the next instance of a defining tag.

Once RMTrak has found all of the document's requirements, it stores them in your project's database.

Parent-Child Relationships

Tag Identification

Requirement Termination

tag_identification.htm
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Terminal Requirements and Documents

Document Types

Depending on your company's needs, you might use many different types of documents with RMTrak. You can set
the document type of your document by using the Modify Document dialog, available by clicking the Properties
button in the main Document dialog.

Default Document Types

RMTrak's default document types include those common to product development. It is possible to create new
document types, edit existing document types or delete a document type at anytime using the Document Types
dialog available from the Setup menu. By keeping RMTrak's list of document types accurate, you ensure that the
information RMTrak provides you in its views and reports are meaningful and beneficial to you.

Default document types included with RMTrak's default installation:

o Customer Requirements Document (CRD)

o Hardware Design Description

o Hardware Requirements Specification

o Hardware Verification Test Procedure (Terminal)

o Product Requirements Document (PRD)

o Product Validation Test Procedure (Terminal)

o Software Design Description (SDD)

o Software Requirements Specification (SRS)

o Software Verification Test Procedure (Terminal)

o System Hazard Analysis (SHA)

The diagram below shows one way to organize these document types. Your own hierarchy may differ.

 

termminal_req_and_doc.htm
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Document Types Dialog

Define Document Type Dialog

Defining Document Types

Applying Document Types to Documents

Terminal Requirements and Documents

Document Hierarchy

Documents are usually ordered so requirements from one document flow down into the next document. With each
lower layer, the information can become more detailed and specific. One possible hierarchy is shown below. This
particular hierarchy can be used in a regulated environment, such as Medical Device Design. This hierarchy
reflects RMTrak's default document types.

You will need to indicate to RMTrak which documents are terminal by specifying it as such in the Document Types
Dialog. This will become especially important when creating Childless Reports to determine which requirements
may have been neglected or forgotten.

Parent-Child Relationships

Document Types Dialog

Terminal Documents

doc_type_dialog.htm
doc_type_dialog2.htm
terminal_req_and_doc.htm
terminal_req_and_doc.htm
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Childless Reports

Parent/Child Relationships

The first document of your project may list many requirements. These requirements can go on to create many
other requirements over the course of the project, which will be listed in subsequent documents.

When writing such requirements, a parent tag is added to link these requirements back to their parent
requirement. In this way, requirements and their status have parent-child relationships.

Just like typical parents and children, a parent or a child requirement can play different roles with respect to those
around it. A requirement can be both a parent (to those that come after it) and a child (to those that come before it).

The following figure shows the relationship of some parent and child requirements. For example, RATM:CRD:1 is
a parent to RATM:PRD:1. RATM:VTR:2 is a child tag of RATM:PRD:2.

Note: This example only shows only a few requirements. In reality, this figure might include hundreds or
thousands of requirements. Also, the organization of these documents and their requirements might not be similar
for your projects.

 

Childless Requirements

Orphan Requirements

Document Hierarchy

Databases

Creating Databases

Creating a database is the first step to working with a new project in RMTrak. To create a new database in RMTrak,
from the File menu, click New. This will start the New Database Wizard.

orphans.htm
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When possible, RMTrak stores filenames in a path relative to the projects database. If you place the database at
the root of the document directory structure, then the entire directory structure can be copied to a new location and
RMTrak will still be able to access the documents. The following figure shows one way to organize the directories
for the default document types.

If you merely type in a name and click Next, the project database will be created in RMTrak's installation directory.
Click Browse to select the filename and location of the RMTrak database you want to create. If the database is to
be shared by more than one person, it is recommended that the database be stored on a network drive that is
accessible to all users. You will not be able to use the name of an existing database.

 
Warning: RMTrak currently cannot support multiple simultaneous users. This
means that only one person at a time can have the project open within RMTrak.
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When you are finished, click Next. You will be asked to choose an option for creating the database.

Option Description

New (Default) You can create a new database with RMTrak's default settings: tags recognized as
any red and bold text, requirements terminated by paragraph mark (¶), and
document numbers and revisions disabled.

New (Custom) You can create a new database with your own customized settings.

Creating New (Default) Database

To create a database that uses RMTrak's default settings, use the New Database Wizard using the New (Default)
option.
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If you choose to create a default database, the documents you add to the database will need to have:

o Tags that are red and bold

o Requirements end with paragraph mark (¶)

o Documents may have revision and numbers, but these are not used by RMTrak.

o TBD Default Document Types

o TBD Default Attributes

If you want to change the default settings for this project, you may still do so after creating the database.

Overview of Setup Options

Creating New (Custom) Database

To create a database in RMTrak that uses custom settings, use the New Database Wizard using the New
(Custom) option.

Note: If you plan to modify only a few options from their default settings, it would be more efficient to select New
(Default) and modify those options after the database has been created.
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Step 1) Specify how tags will be identified

Option Description

Red/Bold Text
This option will set up RMTrak to recognize tags within your documents as
being any text that is both red and bold.

Microsoft Word Style

This option will set up RMTrak to recognize tags within your documents as
being formatted in a specific Microsoft Word style. (Microsoft Word allows you to
format text to have "styles," such as Body Text, Heading 1, Heading 2, and
customized styles.)

If you choose Microsoft Word Style, you will need to type the style name exactly as it appears in  Microsoft Word.

Step 2 - Specify a Requirements Termination Option

When creating a new custom database, the New Database Wizard allows you to specify a character which will
mark the end of each tag.
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Option Description

First paragraph mark following tag
This option specifies that the tags in your documents will each end
with a paragraph mark (¶).

First occurrence of ___ following tag

This option specifies that the tags in your document will each end
with a specific character of your choice (where ___ represents the
specific character). You can type in the character or use the Character
Map Dialog.

 

Carriage Returns

Overview of Tagging

Requirement Termination

Step 3 - Specify a Document Number Option
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Option Description

Do not use document numbers This option specifies that you will not track document numbers.

Document number stored in a Microsoft
Word document property

This option specifies that you will place document numbers in a
customized document property in Microsoft Word.

Document number is stored in the filename
This option specifies that you will place document numbers in
the filename. RMTrak uses regular expressions to specify how
to extract the document number from the file.

 

Document Naming Conventions

Creating and Applying Microsoft Word Styles

Putting Document Information In Filenames

Putting Document Information In Document Properties

Step 4 - Specify a Document Revision Option



22 / 111

Option Description

Do not use document revision This option specifies that you will not track document revisions.

Document revision stored in Microsoft Word
document property

This option specifies that you will place document revisions in a
customized document property in Microsoft Word.

Document revision is stored in the filename
This option specifies that you will place document revisions in
the filename RMTrak uses regular expressions to specify how
the document revision is extracted from the filename.

 

Creating Custom Document Properties

Putting Document Information In Filenames

Putting Document Information In Document Properties

If you choose Document revision stored in a Microsoft Word document property, you will need to specify the
custom name of the Microsoft Word property exactly as it will appear in the Microsoft Word document Properties
listings for your documents.

Step 5 - Select Default Document Types
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Place a checkmark by the types of documents you will be creating for this project. If you will not be using any of
these documents, uncheck each default document type. You can add additional document type after the database
is created by using the Define Document Types option in the setup menu.

 

Document Types

Document Types Dialog

Defining Document Types

Step 6 - Select Default Attributes

Place a checkmark by the types of attributes you will be using for this project. If you will not be using any of these
attributes, uncheck each default attribute type. You can add additional attributes  from the Define Attribute Types
option in the setup menu.

 

doc_type_dialog.htm
doc_type_dialog2.htm
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Attributes

Attributes Dialog

When You Have Finished

When you have finished using the New Database Wizard, RMTrak will create your database at the file location you
selected and immediately open it. You can customize this database's settings at any time by using the Setup
menu.

 

Overview of Setup Options

Opening a Database

There are four ways to open an RMTrak Database.

1. From the File menu, choose Open. Browse to find the location of your file then click Open.

2. From trhe File menu, choose one of the recenetly opened databases.

3. Double-clicking your project's .tra database file located on your computer or server.

4. Specify the filename on the RMTrak command line.

 
Warning: RMTrak currently cannot support multiple simultaneous
users. This means that only one person at a time can have the
project open within RMTrak.

 

Deleting a Database

To delete an RMTrak database, in Windows Explorer, right-click the project's .tra file then select Delete.

 
Warning: If you have Persistent attributes in your project, these
are kept within the RMTrak database. Deleting the database will
delete these attributes.

 

Restoring Deleted Databases

If you have accidentally deleted your RMTrak database, you can restore it easily, provided you have not stored any
Persistent attributes in the database. If you had persistent attributes stored within the database, these cannot be
restored and will need to be recreated.

To restore a deleted database, create a new project database then import each document that was originally in the
database. Because the requirements and attributes were kept in the documents, the new database will be exactly
like the old one.

Copying/Archiving Databases

If you use Persistent attributes in the database, we recommend that you copy/archive your database and
documents periodically. This enables you to easily restore your database should you ever lose it or accidentally
delete it. If you followed RMTrak's recommended directory structure, select all files in the database root directory as
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well as those in sub-directories, copy them and paste them in another location.

Documents

Working with Documents

The documents your company already uses to capture project/product requirements can be directly imported into
RMTrak as they are created, provided you:

1. Create the documents in Microsoft Word.

Warning: RMTrak is not a configuration management tool. Where appropriate,
documents should be placed under configuration control to prevent inadvertent
changes to the documents.

Warning: PC applications can crash and data can be lost. To minimize the
impact, documents should be saved often. The database is saved each time a
change is made.

2. Place tags around each requirement in the documents. (These tags can be made invisible by
applying a Microsoft Word style to them.)

3. Configure RMTrak's setup options to match how you create your documents. These setup options
include how you will tag, where you will keep document numbers and revisions, the types of attributes
you will use, the document types you will import, and more.

4. Give the documents filenames that use the appropriate document naming conventions, depending
on how you have configured RMTrak's Documents Setup.

Rather than internally established restrictions, RMTrak allows the project developer to establish the restrictions
necessary to suit each project. The developer needs only to configure RMTrak to recognize the project's
requirements. For this reason, creating documents has two steps, which can be performed in reverse order if
preferred:

1.Create a new RMTrak database for the project with setup options configured to match how the documents
were created.

Note: These options can be changed after having created the database by using the Setup menu.

2.Create documents that match RMTrak's setup options.

Tag Your Documents As You Create Them

As you create documents for your project, simply place tags around each requirement. If you do not want the tags
to interfere with your document's appearance or normal use, RMTrak allows you to apply a Microsoft Word style to
your tags. This allows you to format your document text to have a specific style, such as invisibility.

Note: If you apply a Microsoft Word style to your tags, be certain you have this option chosen in RMTrak's Document
Setup.

Import Each Document After You Create It

It is important to import documents as they are created. This allows you to view the status of your project's
requirements before proceeding to the next step of the project.

When you import the document into RMTrak, RMTrak will recognize the tags and place the document's
requirements in the database. You should then assign a document type to the document, which allows RMTrak to
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properly place the document in the hierarchy with respect to how it relates to other documents.

Note: For convenience, the list of document types already contains common product development document types,
however you can add, delete, or edit this list to match your company's needs.

 

Tips for Using Microsoft Word

Overview of Tagging

Putting Document Information In Filenames

Putting Document Information In Document Properties

Document Naming Conventions

Document Window

Whether you create a new database or open an existing one, the main window from which you will work is the
Documents Window.

In this window, the documents that have been imported into the database are listed alphabetically (by document
title) in this window. If enabled, RMTrak constantly scans the documents to see which are out of date. Documents
that are determined to be obsolete in the database are displayed with the  icon next to them. This may occur if
the document has been modified subsequent to its last time being imported, or, if you are using revisions, if the
document is a different revision than the one on record in the database.

There are other status indicators displayed to the left of the document title. if the document is read-only a lock, ,

will be display. If an error occurs during the last refresh of the document, an error icon, , will be displayed and if

a warning occured a warning icon, , will be present.

Depending on your project's settings, the Document Dialog will have from two to four columns. The first two
columns are always present and will contain the document title and document type. If you have configured RMTrak
to use document numbers, the third column will contain the document number. If you have enable document
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revisions then the fourth column will be the document revision.

Although it is possible to click the Maximize button in the upper right corner of the Documents Window, we do not
recommend this approach since this makes the Documents Window fill the entire RMTrak window and
consequently obscures all other RMTrak related windows you may have open. Instead, we recommend that you
adjust its size by clicking its lower right corner and dragging it to the desired height and width.

To adjust the width of the columns, place your mouse in the column header and over the vertical line dividing two
columns. Left click and drag to change the width. The sort order is indicated by either a  or a  icon. To
change the sort order, click on the column header by which you want to sort. Clicking the same column that is
currently sorted toggles the sort order between ascending to descending.

The Document dialog allows you to add, delete, refresh, open, and view document properties by clicking on a
document in the list then clicking its corresponding button:

New Opens the New Document dialog and starts the process of adding a new document to the
database

Delete Deletes the selected document from the database. This action will delete all records
associated with the document, but will not delete the document from your system.

Refresh Updates the database's information with information from the document.

Open Opens the document in Microsoft Word. (Double-clicking the document in the Documents
Window list will also perform this action.)

Properties This action opens the Modify Document dialog and allows you to modify the document's Title,
Path and Type, while the Number, and Revision fields remain read-only. To change the
Number, or Revision, you will need to re-import the document.

Importing a Document

Once you have created your database, adjusted its settings, and created a Microsoft Word Document, you will be
ready to import the document into RMTrak. Add the document to RMTrak using the New Document dialog, which is
available by clicking New in the main Documents Window.
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The New Document Dialog allows you to import a document and set its properties. If you have configured RMTrak
to use document numbers or revisions, then RMTrak will display these values in the dialog.

The New Document dialog has the following fields:

Filename This is the document's filename and location. To browse to a document, click the browse
button (…) to the right of the field. If you change the location of the file after importing it into
RMTrak, you will need to open the Modify Document dialog and change its filename so
RMTrak is still able to find the file. Filenames are limited to 250 characters.

Title This is the name of the document. RMTrak pulls the document's title from the Microsoft Word
Title Property. Although this value can be changed within RMTrak it is probably better to
change it within the document itself. See Changing a Document's Title for more information.
Document titles are limited to 50 characters.

Type You can use this drop-down list to choose a document type. Available document types are
determined in the Document Types dialog available from the Setup menu.

Number This is the document number. If you specified the number in the document's properties,
RMTrak will recognize it and place it in this field for you when you import the document
through the Filename field above; otherwise, you can specify it here. Document numbers can
contain letter, numbers or special characters. The maximum length of a document number
is 50 characters.

Note: The Number field will not appear if None is chosen in the Documents Setup.

Revision This is the document revision number. If you specified the revision in the document's
properties, RMTrak will recognize it and place it in this field.

Note: The Revision field will not appear if None is chosen in the Documents Setup.

Should you need to edit the document's properties, you can do so at any time without reimporting the document
using the Modify Document dialog, which is available by clicking Properties in the main Documents Window. Also,
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any time you make changes to your Microsoft Word document, you can refresh the document in RMTrak without
reimporting it: use the Refresh button in the main Documents Window.

 

Documents Window

Adding Documents

Editing Documents Properties

Refreshing Documents

Opening a Document

To open a document in your project's RMTrak database, highlight the document in the Documents Window then
click the Open Button. You can also open the document by double clicking on the document in the Documents
Window. If the "Open Documents as Read-Only" option is enabled then the document will be opened in a Read-
Only mode. In this mode you will not be able to make any changes to the document while in RMTrak. Documents
opened in this manner can be identified by the "(Read-Only)" that appears in the document window's title bar.

 

Documents Window

New Document Dialog

Deleting a Document

To permanently delete a document from your project's RMTrak database, highlight the document in the Document
dialog then click the Delete Button. Click Yes.

 
Deleting a document removes all requirements contained in the
document and their history from the database.

 

 

Documents Window

New Document Dialog

Edit Document Properties

The Modify Document dialog allows you to modify the document's Path, Title and Type, while the Number, and
Revision fields are read-only (to change the Number, or Revision, you will need to re-import the document).

From the Documents Window highlight the name of document then click the Properties Button; the Modify
Document dialog will appear. Choose or type the correct information. When you are finished, click OK.

doc_referesh.htm
doc_new_dialog.htm
doc_new_dialog.htm
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If your document has changed its location, you can update RMTrak by clicking the browse button (...) to the right of
the Filename field. When you choose a file, RMTrak will read and display the document's filename and location in
the Filename field and the document's title in the Title field. If you have added the document's number and/or
revision to the document's filename or document properties, and have selected the corresponding option from the
Document Setup, these options will appear in the Number and Revision fields. The Number option and Revision
fields will not appear if None is chosen in the Documents Setup.

Note: If you have incremented your document to another revision (for example, from revision 1.2 to 1.3), instead of
refreshing the document, you will need to modify its properties and change its file location.

If your document has not changed its location but you want to update RMTrak with a new title, number, or revision
kept in the document's filename or Microsoft Word style, you do not need to change its information in the Modify
Document dialog. If you highlight the document in the Documents Window then click Refresh, RMTrak can refresh
your document's properties with this new information.

Adding documents will affect the list of documents available in the Documents Window.

 

Documents Window

Modify Documents Dialog

Document Naming Conventions

When saving documents to be used with RMTrak:

If you configured RMTrak's Documents Setup to find he document number and/or revision from the filename, the
document's filename must be formatted as follows:

NNNNNNrevR.R.doc

where NNNNNN represents the document number, rev represents the abbreviation for "revision," R.R represents
the revision number (which can be whole numbers or real numbers with up to two places to the right of the
decimal), and .doc represents the Microsoft Word file extension.

For example, the filename 343rev2.1.doc would have the file number 343 and the revision number 2.1.

Note: Revision numbers can be any whole number or integer that does not contain spaces. For example,
3486rev3.4.1.doc and 112386rev21.4 are both valid file names.

If you have configured RMTrak to not recognize document numbers or revisions, or have configured RMTrak to find
the document number and revision in RMTrak's Document Setup, you can name the document any acceptable
Microsoft Word filename.

The naming convention you use must be maintained for all documents within a project. You should also consider
naming all of the documents in your organization (that will be used in RMTrak projects) with the same format.
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Documents Setup

Putting Document Information In Filenames

Putting Document Information In Document Properties

Document Revisions

If enabled, RMTrak will find the document revision in either the document's filename or in a Microsoft Word custom
property. In either case, the format of the document is the same.

0 0.1 0.2 ... 0.9 0.10 ... 1.0 1.1 1.2 ... 1.9 1.10 1.11 ... 2.0 2.1 ... A A1 A1.1 A1.2 ... B C D ... Z Z1 ...

Leading and trailing spaces are ignored.

Example:" 1.0 " is the same as "1.0".

Leading zeros are ignored.

Example:"01" is the same as "1".

"1.00001" is the same as "1.1".

Only a single letter is allowed and it must be at the start of the string.

Example:"0A1" is invalid. "AA1" is invalid.

The number after an initial letter is optional.

Example:"A" is valid. "A0", "A0", "A0.0" are all equivalent.

Revision strings are not case sensitive.

Example:"A" is the same as "a".

Increment Document Revision

If you change the content of your documents, including its requirements, you should save it as a new, incremented
revision. This will distinguish it from previous revisions and help you track changes made to documents over time.
For example, if a product development team reviewed a document and determined it needed changes, the
document could be resaved with a new name and the old document archived. RMTrak does not do this for you; it
will need to do it using Microsoft Word.

Increment Document Number and Saving New File

If you change the contents of a document, you should save it with a new name that reflects its revision. If you have
configured RMTrak's Documents Setup to recognize document numbers in the file name, be certain to follow
document naming conventions for every file.

For example, if you changed the file named:

343rev1.doc

You should save the changed file to the name:

343rev2.doc

This will show the file is now in its second revision. (If you are using the partial increments, you can use
343rev1.1.doc instead of 343rev2.doc). You can then archive the 343rev1.doc file and change the document in
RMTrak.



32 / 111

Update Document Revision In RMTrak

When you increment document revisions (for example, from revision 1.2 to 1.3), RMTrak will automatically
recognize the new revision and update its database with the new information?provided the new file is kept in the
same folder location as the previous revision, and provided you have set up RMTrak to recognize document
numbers and revisions.

Note: If you have incremented your document to another revision and you have RMTrak set up not to recognize
document numbers and revisions or keep the file in a new location, you will need to manually modify its properties
and/or change its file location.

Additionally, if you have configured RMTrak's Document Types dialog to recognize file names, RMTrak will
recognize if a document's revision was inversely incremented (for example, 343rev3.doc added after 343rev6.doc)
and alert you.

If you have made changes to a requirement, RMTrak will mark its child requirements as suspect. Thus enabling
you to create a Suspect Report quickly determine which requirements might also need to be changed.

Document Design

To save time, you should consider using templates for each of your document types. Templates are documents
that have been saved as a .dot file. Depending on your document's purpose, the templates' design and formatting
might vary.

Prometeo Technologies recommend that each document follow a standard format, which includes an introduction,
a body and a conclusion. A table of contents is also advisable for all documents, as it will allow your readers to see
the topics covered by the document at a glance.

Additionally, RMTrak includes sample files which can be used as a standard format. Although you do not need to
copy these formats, if you are new to requirements management, you may find them helpful as templates. To use
these documents as templates, re-save them with a .dot extension to your requirements management directory.

The opening section of a document should include:

· Purpose of the document (its message and contents)

· List of references (other documents referred to within the body of this document)-this establishes a link to
other sources of information

· Table of revision history (the changes to the document should be recorded in this table, including revision
number, description of revision, date revised and author of the revision)

· Any document-specific information (marketing analysis, pricing models, regulations required, financial targets,
etc.)

· Definitions of the requirement tags that will be used in the document (give the words used with the project and
document acronyms) and the definitions of any attributes that are related to the requirements included in the
document.

· The body of the document should be used for listing the requirements and their supporting information. This
text can be formatted in however you prefer, such as in tables or regular text.

 

Working with Microsoft Word

Views

Views allow you to organize requirements in different ways so you can better trace their relationships, attributes,
and status. RMTrak's View dialog lets you create new views, save open views, delete saved views, and open saved
views.

RMTrak currently provides several ways of viewing the information stored in the database.

Tree View A Tree view provides a means of viewing the hierarchical
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relationship between parent/child requirements.

Matrix View
The Matrix view shows the relationships between requirements
and their attributes.

Allocation View
The Allocation view displays the allocation of an Enumeration
Attribute type in a tabular format.

SQL View
A SQL (Structured Query Language) view is similar to a matrix
view except that the table is defined using an SQL String. This
allows for access to all fields of the database.

Tree View

A Tree view provides a means of viewing the hierarchical relationship between parent/child requirements in a tree-
like structure.

Tip: You can see this view in a tabular format by creating a Trace Report.

To create a Tree view, from the Views menu, choose New. The View Dialog will appear. If the Tree Tab is not
visible, click on it.

The documents pane lists the documents in the database. The selected document will be at the top of the tree and
the view will contain all requirements in the selected document plus all of the children that derive from
requirements in the selected document.

In the Tree tab, select a document then click OK.

The tree view displays your document's requirements. Requirements that have a plus (+) sign beside their name
have hidden sub-requirements.
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To reveal these sub-requirements, click the plus sign (+). Similarly, to hide these sub-requirements, clicking the
minus (-) sign.

Regardless of whether the Tree View is forwards or backwards, the arrows point from the Child Requirement to
the Parent Requirement. To show all of the requirements at a particular level, you may Click on the
Views→Show Menu items.
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Clicking on Show ALL will expand all nodes of the Tree View.

If you double-click on a tag in this view, RMTrak brings up the Requirements Dialog.
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If you right click on a Tag, RMTrak will bring up a context menu that allows you to bring up the Requirements Dialog
or go directly to the requirement in the source document.

Selecting the Go To menu item will take you to the tag in the Microsoft Word Document. Clicking the Properties
Menu Item will open the Requirement Dialog.

 

Parent-Child Relationships

Document Hierarchy

Printing

Saving Views

Opening Views

Matrix View

The Matrix view shows the relationships between requirements and their attributes. To create a Matrix view, from
the Views menu, choose New. The view dialog will appear. Select the Matrix tab.
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In the Documents pane, select one or more documents. In the Attributes pane, click the attributes you want to see.
You can select multiple items by pressing the CTRL or SHIFT key as you select attributes. When you are finished,
click OK.

RMTrak will build a view that displays the tags and their attributes for the document and attributes you selected.

In the Matrix view, each row of the table represents a separate requirement and each column represents a
particular attribute. Double clicking on a requirement will bring up the Requirements Dialog. Right clicking on a
requirement will bring up a context menu that will allow you to bring up the Requirements Dialog, go directly to the
requirement in the source document, or filter the contents of the view.
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Tip: You can sort each column in the Matrix view by clicking its column header.

 

Printing

Saving Views

Opening Views

Allocation View

The Allocation view displays the allocation of an Enumeration Attribute in a tabular format. To create an Allocation
view, from the Views menu, choose New. The View Dialog will appear. Select the Allocation tab.

The Documents Pane lists the document in the database. The Attributes pane lists the Single and Multi Valued
Enumeration Attributes. Select one document and one attribute and click OK.
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When an Allocation view is created, each row in the view represents an individual requirement, and each column
represents the possible values of the attribute. An X in a cell indicates the requirement's attribute is associated
with that particular value. If the views says (READ-ONLY) at the top, this is because the attribute is not Persistent.
Persistence can be adjusted in the Attribute Edit dialog.

If you double click on a row the Requirement dialog fill open. If you right click on a Tag, RMTrak will bring up a
context menu that allows you to bring up the Requirements Dialog or go directly to the requirement in the source
document.

The ability to allocate a requirement's values within the Allocation view eliminates the need to assign the attributes
to the requirement from within the document by using tagged attributes.

The ability to change the attributes in the Allocation view differs by whether Enum (Single) or Enum (Multiple) is
chosen in the Attributes dialog:

?If the attribute's Type is set to Enum (Single), you can assign a requirement to one of value listed in the Rules
field.

For example, if the attribute's Type is Enum (Single) and the Rule is set to HW;QA;SW, you can assign a
requirement using that attribute the value HW or QA or SW. You may only choose one of these values to apply to
your requirement.

?If the attribute's Type is set to Enum (Multiple), you can assign a requirement to any/all values listed in the Rules
field.

For example, if the attribute's Type is Enum (Multiple) and the Rule is set to HW;QA;SW, the attribute's value (listed
within the document or the Allocation view) can be HW, QA and/or SW, or any combination of choices.

 

Warning: If you plan to use Persistent Attributes, we recommend that you
periodically save a backup copy of the database. Otherwise, should you lose the
database, the externally defined values for those Persistent Attributes would also be
lost.

 

Changing the Values of Persistent Attributes within the Allocation View

To change a requirement's Persistent attribute values from within the Allocation view, double-click the correct cell;
then select the appropriate value(s) for the requirement. In accordance with whether the attribute's value was
defined as Enum (Single) or Enum (Multiple) you will be allowed to select single or multiple values for the
requirement.

Note: If an attribute is Persistent, you will not need to add this attribute's values to your tags.

Changes made within the Allocation view are automatically saved when the Allocation view window is closed.

 

Printing

Saving Views

Opening Views

SQL View
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A SQL (Structured Query Language) view is similar to a matrix view except that the table is defined using an SQL
String. This allows you to access any field in the database quickly and easily.

Note: If you want to perform SQL queries, you should first review the database schema.

SQL is a syntax that is used to retrieve information from a database. If you are familiar with SQL, you can create
SQL queries by clicking the Views menu, choosing New, then selecting the SQL tab.

To enter SQL commands, type your SQL commands in this window then click OK. To specify multiple SQL
statement, separate each statement with a semicolon. For information on SQL syntax, see the SQL Syntax topic.
When you click OK, your query's results will show in the SQL View window.

Tip: You can sort each column in the SQL view by clicking its column header.

 

Printing

Saving Views

Opening Views

Creating a View

To create a new view, click the Views New menu item. This will open the View Dialog.
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Click on the tab for the type of view that you are creating, select the appropriate data and click OK.

Saving a View

While a view window is open, from the Views menu, choose Save or Save as. Type a name for the view then click
OK. Saved views are available to all users of the RMTrak project database.

Opening a View

To open a saved view, from the View menu, choose Open, highlight the desired view and click OK.
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When you open a saved view, RMTrak creates the view in the format in which it was last displayed. The information
in the view may have changed because the documents may have been refreshed, but the format of the view will be
the same.

Deleting a View

To delete a saved view, from the Views menu, choose Delete, highlight the name of the view you wish to delete,
click OK then click Yes.

 
Warning: Deleting a view will delete it for all users of the database. Do not delete a
view unless you are certain that no other user will need it in the future.

 

Filters

Filters provide a way to limit the number of requirements in a View or a Report. A Filter is a series of conditions that
a requirement must pass in order to be included in a report or view. For example, if you are looking at a Childless
Report that contains requirements from multiple documents.
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You can use a filter, Document Type = System Hazard Analysis, to eliminate all requirements except those that are
in the System Hazard Analysis.

When a report or View is being filtered the title bar will contain the words "Filtered".

 

Filter Dialog

Filter Dialog

In order to create or modify a view, select the Views->Filter Menu item or press Ctl-E.
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The Filter Dialog allows you to add and delete terms from a Filter.

Filter Term Dialog

If the filter already contains a term, then the first item on the dialog will be the Boolean operator. This value be
either AND or OR.

Reports

 Reports

 

Once you have added the documents and their requirements to RMTrak, you can begin to relate and evaluate the
project's requirements. RMTrak allows you to generate several different types of reports from your documents,
including:

Change Report

Childless Requirements Report

Closure Report

Orphan Requirements Report

Requirements Summary Report

childless.htm
orphans.htm
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Suspect Report

Trace Report

Unallocated Requirements Report

RMTrak also allows you to add Custom Reports.

Trace Report

The Trace Report shows you how one document's requirements traced from other, previous document's
requirements.

Tip: You can also see requirements tracing in the Tree View.

To create a Trace Report, from the Reports menu, choose Trace Report. The Trace Report window will appear.

The Trace Report window has this field:

Documents
A list of documents imported into the current
project.

Select the document(s) from which you wish to trace requirements and click OK. You can select multiple
documents by pressing CTRL or SHIFT as you select. RMTrak, by default, selects all documents for you.

RMTrak will generate a read-only report of requirements and their tracing.

 

report_suspects.htm
report_unallocated.htm
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Types of Reports

Printing Reports

Adding In Reports

Requirements Summary Report

A Requirements Summary Report shows a requirement's text and associates it with all of its children's
requirements text. This is helpful when reviewing the tracing of a requirement and all of its derivatives. With the
Requirements Summary report, you can follow the traceability of the requirements from the broad level to specific
testing results. Such traceability is important when reviewing a solution to ensure it is correct and complete.

The Requirements Summary Report is also useful for ensuring that all of your child requirements match the scope
and function of their parents.

For example, the flow chart below shows several requirements and how they relate to each other.

This project's Summary Report would have this information for the CRD and PRD documents:

RATM:CRD:1 Circuit shall be designed to minimize impact of faulty ground.

     RATM:PRD:1 GFI shall be included in hardware.

RATM:CRD:2 System shall prevent moisture from entering environment.

     RATM:PRD:2 Watertight box shall be used.

RATM:CRD:3 Damage to the unit shall be detected by regular inspection.

     RATM:PRD:3 Periodic maintenance shall be required.

 

Creating Requirements Summary Reports

To create a Requirements Summary Report, from the Reports menu, choose Requirements Summary. The
Requirements Summary window will appear.

report_add.htm
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In the Parent pane, select the document of a parent tag. In the Child pane, select on or more children, then click
OK. If no children are visible then the Parent Document selected does not contain any children and Requirements
Summary Report can not be generated. Once OK is clicked, RMTrak will generate a Requirements Summary
report.

 

Types of Reports

Printing Reports

Adding In Reports

Change Report

The Change Report allows you to view the changes that have been made to a requirement or its attributes. To
create a Change Report, from the Reports menu, choose Change Report. The Change Report dialog will appear.

report_add.htm
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The Change Report dialog has these fields:

Document Types

   

Document types available for this
project. This list can be altered within
RMTrak's Document Types dialog.

Documents
   

Documents that have been imported
into RMTrak.

Change Types

   

Types of change on which you may
want to focus for your report include:
Feature Change, Requirement
Change, Requirement Change,
Requirement Creation, and
Requirement Deletion.

Date

   

Specify the date(s) you would like for
the report to include: All, Since,
Before, Between. If you select Since,
Before, or Between, fields will appear
so you may type those dates.

Select the document types, documents, and change types you want to examine in the report. To select multiple
items, press CTRL or SHIFT as you select items. By default, RMTrak selects all documents.

Choose date(s) you would like to focus on for your report, then click OK.

RMTrak will generate a read-only report of changes that have occurred with the document's requirements.
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Types of Reports

Printing Reports

Adding In Reports

Closure Report

A closure report shows the closure status of the requirements contained in a document. A requirement is
considered closed if all the tests that trace, directly or indirectly, back to it have passed.

For example, in the requirements below, you can see that the RATM:VTR:1, RATM:VTR:3, and RATM:VTR:5
requirements have passed their tests, but RATM:VTR:2 and RATM:VTR:4 requirements have not.

In this example, the RATM:VTR:1, RATM:VTR:3, and RATM:VTR:5 requirements would be marked as closed.

Because parent requirements are closed when their children are closed, in the above example, the RATM:CRD:1,
RATM:PRD:1, RATM:CRD:3, RATM:PRD:3, and RATM:PRD:5 requirements would also be closed.

report_add.htm


50 / 111

The following diagram illustrates this closure relationship (where red requirements are closed and black
requirements are still open; arrows show direction of parent-child relationship).

In addition to closed requirements, if a parent requirement's children are each found to be closed, the parent
requirement will also be shown as closed.

 

Warning: Make sure all of your project's documents have been imported into the
RMTrak project. RMTrak cannot recognize requirements of documents that have not
been imported. If a parent requirement has an open child requirement listed within
a document that has not been imported, RMTrak might still list the parent
requirement as closed (if the children requirements of the imported documents are
closed).

 

Creating Closure Reports

To create a Closure Report, from the Reports menu, choose Closure Report. The Closure Report dialog will
appear.

Select a document. From the drop-down lists, select which types and names of attributes RMTrak should check for
when creating a closure report.

Tip: Selecting <None> from the drop-down list tells RMTrak that it should not include that attribute type in closure
reports, and/or your requirements do not use that type of attributes. If selecting an attribute (anything other than 
<None>), be sure to select the correct attribute for its type. For example, if your organization uses a customized test
method attribute called "Method," be sure to select Method from the Test Method Attribute drop-down list (and not
from any other drop-down list).
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Documents using RMTrak's default attributes may have the following selections.

o Ownership Attribute: Tester or <None>

o Test Pass Attribute: Test Pass or <None>

o Test Method Attribute: Test Method or <None>

o Test Date Attribute: Test Date or <None>

When you have finished, click OK. RMTrak will generate a report that shows the requirements and indicates which
are closed and which are still open.

Closure Reports will be especially helpful toward the end of a project when it is most important to determine which
requirements have not successfully passed their tests.

For additional information, see the Closure Reports Dialog topic.

 

Parent-Child Relationships

Requirement Identification

Tag Identification

Terminal Requirements and Documents

Types of Reports

Printing Reports

Adding In Reports

Childless Requirements Reports

tag_identification.htm
terminal_req_and_doc.htm
report_add.htm
childless.htm
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Custom Report

RMTrak has the ability to generate custom reports. These reports integrate with RMTRak through an API defined in 
How To Write Custom Reports. This document can be found on the RMTrak Website along with a list of custom
reports that are available for download.

 

Adding a Custom Report

Removing a Custom Report

Adding Custom Report

A Custom Report can be added to the application either through the report's installation or manually by the user. To
manually add the report, click on the Reports → Add-In menu item.

Click on the New button.

https://www.rmtrak.com
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Browse to the Custom Report file and click the Open button.

 

Custom Reports

Removing a Custom Report

Removing Custom Report

A Custom Report can be removed from the application either through the report's uninstallation or manually by the
user. To manually remove the report, click on the Reports → Add-In menu item.
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Click on the Delete button.

Click the Yes button.

Note: The Custom Report file is not removed from the system when it is removed from RMTrak. It can be added
back at a later date.

 

Custom Reports

Adding a Custom Report

Printing Reports

To print a report, when the report window is open, from the File menu choose Print or Print to File.

 

Types of Reports

Childless Report

A childless requirement is a requirement that has no requirements tracing back to it but is not contained in
a terminal document.

Cause of Childlessness Fix
1. The document containing the child

requirement has not been imported into the
Make sure you have imported all your documents
into RMTrak.
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database.
2. The associated requirement was inadvertently

left out. 
Create a Childless Report to determine in which
document the childless requirement was included,
then write the necessary requirement that traces
back to the childless requirement.

3. The requirement has been misspelled or
misidentified in its parent document. It would
consequently appear that a child requirement
has been forgotten or neglected to be
included.

Create a Childless Report to determine in which
document the childless requirement was included,
make the appropriate edit to the associated
requirement in the next document in your project's
hierarchy.

4. The requirement is in a document that should
be a terminal document. 

Change the document type of that document to be
terminal.

       

To determine if your project has any childless requirements you should run a Childless Report which
displays every childless requirement that is not part of a terminal document. It is important to create a
Childless Report after importing each document in order to avoid missing any requirements as you move
forward in the development process.

To create a Childless Report, from the Reports menu, choose Childless. The Childless Report will appear
containing a list of all of your project's childless requirements.

Double clicking the tag will bring up the Requirements Properties Window. Right clicking the tag will bring
up a context menu that will allow you to either go to the requirement or open the Requirements Property
Window.

Parent-Child Relationships

Orphan Requirements

Document Hierarchy

Terminal Requirements and Documents

Report Types

Printing Report

Filtering Report

Orphan Report

An orphan requirement is requirement that lists a parent requirement that does not exist in the RMTrak
database.

For example, the child requirement below lists the parent requirement [RATM:PRD:11].

RATM:VTR:11 The circuit shall be interrupted when the ground is shorted.
{Test Method = I} [RATM:PRD:11]¶

However, if RATM:PRD:11 does not actually exist anywhere but here, as a “parent” reference, RMTrak will
mark this requirement as an orphan (meaning its parent does not actually exist).

Cause Fix

1. The document containing the parent
requirement has not been loaded into the
database.

Make sure you have imported all your documents
into RMTrak.
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2. There is a typo in either the parent tag or the
defined/child tag.

Create an Orphaned Report to see which
requirements are orphans, then manually fix the
problem in your documents.

Creating Orphan Reports

To create an Orphan Report, from the Reports menu, choose Orphans.

The Orphans Report will appear and list all of your project's orphan requirements.

Double clicking the tag will bring up the Requirements Properties Window. Right clicking the tag will bring
up a context menu that will allow you to either go to the requirement or open the Requirements Property
Window.

Parent-Child Relationships

Childless Requirements Reports

Document Hierarchy

Types of Reports

Printing Reports

Adding In Reports Filters

Suspect Report

If you modify or change a parent requirement, the child requirements might also need to be modified. For
example, if a requirement in the Product Requirements Document says:

     Internal temperature control shall be activated if temperature rise is greater than 15 degrees
ambient.

You may determine later in the project that this is incorrect then change it to:

     Internal temperature control shall be activated if temperature rise is greater than 16 degrees
ambient.

Unfortunately, this will make child requirements, such as one in the Product Validation Testing Procedures,
inaccurate:

     When temperature is increased by 15 degrees above the ambient, the system will shut down.

If your project has thousands of requirements, this one could easily be overlooked, To help keep track of this
type of problem RMTrak marks the children of changed requirements as “suspect.” This provides the
developer with an efficient means of examining all requirements derived from modified requirements so s/he
may review each child requirement carefully to see if it also needs changing.

Finding Suspect Requirements

There are two ways to view suspect requirements in RMTrak:

    Create a Suspect Report to view a list of all suspect requirements.
    Create a Tree view, Orphan Report, Childless Report, or Unallocated Report. Suspect requirements will
be designated with an S symbol. If you double-click the suspect requirement, a window will open showing
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its properties. If you determine that the requirement is still valid, click on Suspect to remove the tag's
suspect status.

You should create a Suspect Report after each time you modify and refresh a document to see if any parent
tags have changed. If any parent tags have changed, RMTrak will list their children in its Suspect Report.

Creating a Suspect Report

To create a Suspect Report, from the Reports menu, choose Suspect.

The Suspect Requirements Report will appear and list all of your project's suspect requirements.

If you double-click a suspect requirement in this list, a window will appear showing your requirement's
properties.
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Removing the “Suspect” Status from the Requirement

Once you have ensured that the “suspect” requirement in question was correctly and necessarily modified,
you can let RMTrak know to update its database of the new, correct parent tag by simply highlighting the
document in the main Documents Window then clicking the Refresh button.

You can also create a Tree view. Suspect requirements are designated with ‘(s)' in the Tree view. If you
double-click the suspect requirement in the Tree View, a window will open showing its properties. If you
determine that the requirement is still valid, click the Suspect button to remove the tag's suspect status.

Warning: If you have a report or view open, removing a requirement's suspect
status will not update the report or view until the next time the report or view is
created.  

  

Types of Reports

Printing Reports

Adding In Reports

Filters

Unallocated Report

When you add attributes to the Attributes Dialog, you give it a name, a data type, and a rule (if applicable).

When you put the attribute and its tags around the requirement in its document, you also list its value. For
example, in the following example, the attribute {Test Method = I} has the value I; however, this value could
have been I, A, D, or T (Inspection, Analysis, Detection, or Test) since I;A;D;T is listed as this attribute's
rule (in the Attributes Dialog).
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RATM:PVTR:1 The circuit shall be interrupted when the ground is shorted.
{Test Method = I} [RATM:PRD:1]¶

If you neglect to give the attribute its related value, as in the following example, RMTrak will notice this and
consider it an “unallocated requirement.”

RATM:PVTR:1 >The circuit shall be interrupted when the ground is shorted.
{Test Method} [RATM:PRD:1]¶

Because the test method above does not specify which test method it used (I, A, D, or T), its test method is
missing, or this requirement has an unallocated attribute. If this requirement has an unallocated attribute,
the requirement will also be unallocated.

RMTrak will also consider any requirement that does not have an attribute applied to be an unallocated
requirement. For example, in the following requirement, no attribute is listed. This requirement is therefore
considered “unallocated.”

RATM:PVTR:1 The circuit shall be interrupted when the ground is shorted.
[RATM:PRD:1]¶

You should create an Unallocated Requirements Report after adding each document. RMTrak can then help
you determine if you have neglected to add attributes to a requirement or values to an attribute.

Creating an Unallocated Requirements Report

To create an Unallocated Requirements Report, from the Reports menu, choose Unallocated

The Unallocated Requirements Dialog will appear.

In the Documents pane, select a document. In the Attributes pane, select an attribute, then click OK.

RMTrak will generate a report of the attribute for that document and any matching unallocated requirements.
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If you double-click an unallocated requirement in this list, a window will appear showing your requirement's
properties.

Types of Reports

Printing Reports
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Adding In Reports

Configuration

Options

RMTrak lets allows the user to adjust the formatting/identification and requirements termination of tags as well as
the document and revision numbering of your project at any time. RMTrak's default options are determined when
you initially create the database. These default options can be changed at any time using the Options dialog
available from the Setup menu. The Options dialog has four tabs: Tags, Requirements, Documents, and
Miscellaneous.

The following table provides explanations of available options.

Tab Category Options Explanation

Tags Tag Identification Red/Bold Text This option will set up RMTrak to recognize tags within your
Documents as being any text that is both red and bold.

Tags Tag Identification Microsoft Word Style This option will set up RMTrak to recognize tags within your
Documents as text formatted in a specific Microsoft Word style.
(Microsoft Word allows you to format text to have "styles," such as
Body Text, Heading 1, Heading 2, and customized styles.) If you
choose this option, you will need to specify the name of the Microsoft
Word style exactly as it appears in Microsoft Word.

Requirements Requirement Termination Paragraph mark This option specifies that the tags in your documents will each end
with a paragraph mark (¶).

Requirements Requirement Termination Special Character This option specifies that the tags in your document will end with a
specific character. If you choose this option, you will need to type the
character exactly as it will appear in your documents, or paste it from
the clipboard. If you need help choosing a character, you can click
the Char Map button to open the Character Selector (double-click a
character to select it).

Documents Document Number/
Revision

None This option specifies that you will not track document numbers.

    Contained in the
filename

This option specifies that you will place document numbers in the
filename. If you want to specify document numbers in the filename,
the format must be NNNNNNrevR.R.doc, where NNNNNN
represents the document number, rev represents the abbreviation
for "revision," R.R represents the revision number (which can be
done in pointed increments or whole numbers), and .doc represents
the Microsoft Word file extension.

Note: The revision numbers can be any whole number or integer that
does not contain spaces. For example, 3486rev3.4.1.doc and
112386rev21.4 are both valid file names.

Documents Document Number/
Revision

Contained in the
document properties

This option specifies that you will place document numbers in a
custom property in Microsoft Word's document Properties dialog. If
you choose this option, you will need to type in the space provided
the custom name of the Microsoft Word property exactly as it will
appear in the Microsoft document Properties listings for your
documents.

Miscellaneous Open Documents as
Read Only

Checked/Unchecked When this property is checked, RMTrak will open documents in a
read-only mode. Thus documents can not be inadvertently modified.
When this property is unchecked, RMTrak will open documents in a
read-write mode, which allows for easier updating of the documents.

Miscellaneous Open Last Database At
Startup

Check/Unchecked When this property is checked, RMTrak will attempt to open the last
database that was open upon Startup.

Miscellaneous Enable Background Check/Unchecked When this property is checked, RMTrak will continually check for

char_map.htm
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Obsolete Document
Check

obsolete documents. This is done in such a way that it will not
interfere with the other operations of the computer.

Options Dialog

Tags Setup

Requirements Setup

Documents Setup

Putting Document Information In Filenames

Putting Document Information In Document Properties

Options Dialog

The Options Dialog is available from the Setup menu.

The Options Dialog allows you to configure a project's options. To select an option to configure, click the tab
containing that name in the Options Dialog. When you are finished, click OK.

The Options Dialog has the following sections:

TagsFor tag identification, choose either red/bold text or a Microsoft Word style.

RequirementsChoose requirement termination as either a hard return or a special character.

DocumentsChoose document and revision numbering as being placed in the filename, the Microsoft Word
properties, or neither.

MiscellaneousAllows you to control how RMTrak will behave.
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Tips for Using Microsoft Word

Tags Setup

Requirements Setup

Documents Setup

Tag Options

A project's options are determined when the project is created. These default options can be changed at any time
using the Options Dialog available from the Setup menu.

When you select the Tags tab, the Tags setup options appear.

 

The Tags Tab has two options:

Red/Bold Text This option will set up RMTrak to recognize tags within your documents as being any text that is both red and
bold.

Microsoft Word Style This option will set up RMTrak to recognize tags within your documents as being formatted in a specific
Microsoft Word style. (Microsoft Word allows you to format text to have "styles," such as Body Text, Heading 1,
Heading 2, and customized styles.)

If you choose Microsoft Word Style, you will need to type the name of the Microsoft Word style exactly as it
appears in Microsoft Word.

Working with Microsoft Word

Options Dialog

Overview of Tagging

Tag Identification

working_with_word.htm
tag_identification.htm
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Requirement Options

A project's options are determined when the project is created. These default options can be changed at any time
using the Options Dialog available from the Setup menu.

When you select the Requirements tab, the Requirements setup options appear.

The Requirements section has two options for termination tags and their requirements:

Paragraph Marks This option specifies that the requirement text in your documents will each end with a paragraph mark (¶).

Note: If you are using a paragraph mark to indicate the termination of a requirement, you should use soft returns
(SHIFT+ENTER) for any line breaks within the requirement.

Special Character This option specifies that the requirement text in your document will each end with a specific character of your
choice.

If you choose the Special Character option, you will need to type in the space provided the character exactly as it
will appear in your documents, or paste it from the clipboard. If you need help choosing a character, you can click
the Char Map button to open the Character Map Dialog.
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Tips for Using Microsoft Word

Overview of Tagging

Character Map Dialog

The Character Map Dialog lets you select a character as the Requirement Terminator. You select the
character by double-clicking it or by selecting it and clicking the OK button.
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Document Options

A project's options are determined when it is created. These default options can be changed at any time using the
Options Dialog available from the Setup menu.

When you select the Documents tab, the Documents setup options appear.
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The dialog has two sections: Document Number and Document Version.

Document Number

The Document Number section has these three options:

  None This option specifies that you will not track document numbers.

 
Contained in the filename This option specifies that you will place document numbers in a customized document

property in Microsoft Word.

 
Contained in the document property This option specifies that you will place document numbers in the filename. The format must

use the correct document naming conventions.

If you choose Contained in a Microsoft Word document property, you will need to type the name of the Microsoft
Word property exactly as it appears in the Microsoft Word document Properties listings of your documents.

Document Version

The Document Version section has these three options:

None This option specifies that you will not track document revisions.

Contained in the filename This option specifies that you will place document revisions in the filename If you want to specify
document revisions in the filename, the format must be NNNNNNrevR.R.doc, where NNNNNN
represents the document number, rev represents the abbreviation for "revision," R.R represents
the revision number (which can be done in pointed increments or whole numbers), and .doc
represents the Microsoft Word file extension.

Note: The revision numbers can be any whole number or integer that does not contain spaces.
For example, 3486rev3.4.1.doc and 112386rev21.4 are both valid file names.

Contained in the document property This option specifies that you will place document revisions in a customized document property
in Microsoft Word.

 

Options Dialog

Document Naming Conventions

Tips for Using Microsoft Word

Putting Document Information In Filenames

Putting Document Information In Microsoft Word Properties

Regular Expression Dialog

RMTrak uses regulasr expressions for extracting the document number and version information from a
filename. You are probably familiar with wildcard notations such as "*.txt" to find all text files in a file
manager. Regular expressions take wildcards to the next level. The regular expression contain one and only
one group. The group specifies how the information will be extracted.
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The dialog allows you to specify the Regular Expressions for the Document Number and Document Version.
It also allows you to test that the regular expressions that you entered work with you document names.

Example 1: Filenames with the format “NNNNNNrevR.R.doc”.

Number Regex : (.*)rev.*

Revision RegEx: .*rev(.*).

Example 2: Filenames with the format “NNNNN_title_revR.R.doc”.

Number Regex : “(.*) *”

Revision RegEx: .*rev(.*).

Example 3: Filenames with the format “title_NNNNNrevR.R.doc”.

Number Regex : “_(.*)rev”

Revision RegEx: rev(.*)\.[dD]

Regular Expression Syntax

Regular Expressions

A regular expression (regex or regexp for short) is a special text string for describing a search pattern. A
regular expression is made up of characters. Some of them have special meanings and other are taken
literally.

For example, the regular expression "a.z" would match "abz", "acz", and "az". Where as the regular
expression "a.*z" would match all of the previous and "abcz", and abcdefghijkz".

Expression Description
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. Matches an single character.

[ ] Matches a single character that is contained in the bracket. Either individual
characters can be specified (eg. "[0123456789]") or a range can be specified (eg. "[0-
9"]).

[  ̂] Matches a single character that is not contained in the bracket.

^ Matches the start of the string.

$ Matches the end of the string.

? Indicates that there are zero or more of the preceding expression. This is usually used
with the "." to indicate a string of characters.

+ Indicates that there are zero or one occurences of the proceding expression.

( ) This indicates a group.

\ This is the escape character. If you need to include one of the special characters as a
literal, then the escape must precede the character. For example, if you were
searching for a period, you woul need to use "\.".

literal Any character not previously identfied is a literal. The string must contain this
character in order to match. 

Miscellaneous Options

The options contained on the Miscellaneous Setup tab control how RMTrak behaves. They do not have any affect
on the project or the project's database. These options can be set on a per user basis and can be changed at any
time using the Options Dialog available from the Setup menu.

When you select the Miscellaneous tab, the Miscellaneous setup options appear.

Open Documents as Read-Only When this option is enabled, RMTrak opens documents in a read-only mode.

Open Last Database at Startup When this option is enabled, RMTrak will open the database that was last in use when it starts
up.

Enable Background Obsolete Document Check When this option is enabled, RMTrak will continually scan a project's database looking for
changes. If changes are detected then RMTrak will mark the documents as obsolete.
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Tag Filter

To allow more than one project to share documents, RMTrak has a tag filter. The tag filter allows you to keep tags
and requirements that belong to another project from entering the database. The tag filter works similarly to a
search string in a word processor. RMTrak´s default settings do not use any tag filters.

How It Works

When you import a document that has tags, RMTrak, by default, imports all of the requirements tagged within the
document. If you use documents for more than one project, this could confuse your views and reports with
information from two projects. By adding tag filters, you are telling RMTrak which tags are intended for this project
so RMTrak knows to ignore all others.

For example, a document could have information about separate products. In the example below, a project called
the Revolutionary Automated Teller Machine (RATM) has three distinct models: RATMN (RATM Network), RATM (the
machine), and RATMW (RATM Wireless). Both the RATMN and the RATMW includes the RATM requirements, but
the RATMN and RATMW have separate requirements.

In the document, this can be shown as follows:

Requirements for the RATM:

RATM:PRD:1 The system will dispense money.

RATM:PRD:2 The system will use encryption when transferring PINs.

Additional requirements for the wireless system only:

RATMW:PRD:3 The system will have wireless access.

Additional requirements for the network system only:

RATMN:PRD:4 The system will have network access.

If you imported a PRD with these tags into RMTrak, RMTrak would, by default, trace all of the tags. But because you
do not want the RATMW and RATMN tags in the same project, you need a way to tell RMTrak that for one project
you would like to include the RATMN and RATM tags, and in another project you would like to include the RATMW
and RATM tags.
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RMTrak makes this easy to do with its tag filter. After creating two separate projects in RMTrak (one for RATMN and
another for RATMW), you would need to define tag filters for each project so that only the correct tags are imported
into the project.

In the RATMN project, you would add these tags to the tag filter:

RATM:*

RATMN:*

This tells RMTrak that only requirements beginning with "RATM:" or "RATMN:" should be imported into the
database.

In the RATMW project, you would add these tags to the filter:

RATM:*

RATMW:*

In this case only requirements beginning with "RATM:" or "RATMN:" would be imported.

This makes sure that both projects include the general requirements but do not include the specific requirements
of the other related project.

 

Tag Filter Dialog

Tag Filter Dialog

To allow more than one project to share documents, RMTrak has a tag filter. The tag filter allows you to keep tags
and requirements that belong to another project from entering the database. RMTrak's default settings do not have
any tag filters. You can use the tag filter to keep tags and requirements that belong to another project from entering
your project's database. The Tag Filter dialog is available from the Setup menu.

When you define a tag filter, use the first part of the tag, followed by its colon, followed by the rest of the appropriate
portion of the tag that will be shared by more than one project. If you want to use every kind of tag of that type, use
an asterisk (*) to match zero or more characters.

Note: The above example shows the tag filter with RATM:*. By default, the tag filter is * (accepting all tags). In this
example, the tag filter allows RMTrak to accept all tags beginning with RATMN: for this project.

The Tag Filter dialog allows you to add and delete filters by either typing the tag in the first field provided or
selecting it from the list, then clicking its corresponding button:
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New - Adds a tag filter.

Delete - Deletes the selected tag filter.

Note: This button will not become available until you have selected a tag filter from the list.

Done - Closes the Tag Filter dialog.

 

Tag Filter

Defining Document Types

RMTrak installs several default document types, the properties of these types may be added to, edited, or
deleted at any time. You may edit the default document types after creating each project. To define
document types, use the Document Types Dialog available from the Setup menu.

·To add a document type, click New. This will open the Define Document Type dialog.

·To edit a document type, click Properties. This will open the Edit Document Type dialog.

·To delete a document type, highlight the document type then click Delete.

Document Types

Document Types Dialog

Document Type Dialog

If you click the Properties button in the Document Types Dialog, which is available from the Setup menu, the
Document Type dialog appears.
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The Document Type dialog has these fields:

Name Document type names are limited to 50 characters and may include spaces.

Default Attributes Select the default attributes you want to make available for this document type:

The list in the left pane shows the default attributes selected for this document type. The list in the right pane
shows the list of available attributes. This list can be modified in the Attributes dialog.

Terminal This check box shows whether the document type is the final, terminal document in your document hierarchy.

 

Document Types

Document Types Dialog

Defining Document Types

Applying Document Types to Documents

Terminal Requirements and Documents

Defining Attributes

You can insert attributes into your documents for RMTrak to use in determining the status of requirements
or to enable users to query and sort the requirements. The setup option for attributes tells RMTrak which
attributes you will be using.

doc_type_dialog.htm
terminal_req_and_doc.htm
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To define attributes, use the Attributes Dialog available from the Setup menu.

·To add an attribute, click New. This will open the Attribute Edit dialog.

·To edit an attribute, click Properties. This will open the Attribute Edit dialog.

·To delete an attribute, select it from the list then click Delete.

When adding or editing attributes, choose a data type from the Type list; this list can be edited from the
Attributes Window. If you choose Enum (Single) or Enum (Multiple), you will need to add a rule in the Rule
field. To create or edit a rule, use the attributes' data types and rules syntax. If the attribute value is
Persistent, check the Persistent check box. You can assign the Persistent attribute's values to the
requirement from within RMTrak's Allocation view.

Attributes

Attribute Edit Dialog

Attributes' Data Types and Rules Syntax

Overview of Tagging

Attributes Dialog

If you click the New or Properties button in the Attributes Dialog, the Attribute Edit dialog appears.

The Attribute Edit dialog has these fields:
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Name The name of the attribute will appear whenever the attribute is referenced. Attribute names
are limited to 50 characters.

Type This indicates the data type of the attribute. For more information about data types, see
the Attributes' Data Types and Rules Syntax topic.

Rule Rule used to validate the value assigned to an attribute. The application ensures that only
valid values are assigned to an attribute. You will only need to specify a rule if you have
selected Enum (Single) or Enum (Multiple) from the data Type drop-down list. For more
information about rules, see the Attributes' Data Types and Rules Syntax topic. Attribute
rules are limited to 200 characters.

Persistent Checking the box indicates that the attribute is persistent. Persistent attributes are stored
in the database, whereas non-persistent attributes are stored in the document. If the
Persistent check box is checked for an attribute, the attribute's values can be assigned to
requirements from within RMTrak's Allocation view This eliminates the need to specify this
attribute in your documents' tags.

Warning: If you plan to use Persistent Attributes, we recommend that you
periodically save a backup copy of the database. Otherwise, should you lose the
database, the externally defined values for those Persistent Attributes would
also be lost.  

Attributes

Defining Attributes

Attributes' Data Types and Rules Syntax

Overview of Tagging

Working with Microsoft Word

Document Titles

A document' s title is just another document property. It is changed from the Properties Dialog. To
access the Property Dialog, click on the File->Properties Menu Item.
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Click on the Summary Tab.
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Enter the title and then click OK.

Custom Document Properties

You can add custom document properties to your documents by using the Custom tab. In Microsoft Word,
from the File menu, choose Properties, then click Custom. Add the custom properties you desire (for
example, Number or Revision). When you are finished, click OK.
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In the example above, the custom properties are called Docnum and Docrev. Custom properties can be
named anything the author finds applicable as long as long as RMTrak's Document Setup is configured with
matching property names. Remember that document revisions can be whole numbers (1, 2, 3, etc.) or real
numbers with up to two places to the right of the decimal (1.35, 2.63, 9.65, etc.).

For more information on approaches to creating custom properties, see the Putting Document Information In
Document Properties topic.

Formatting Text to Be Bold and Red

One option for formatting text is to format your tags to be bold and red. There are many ways to do this and serveral
are presented below.

Word 2003
Option 1

1. Select the tag.
2. From the Format menu, choose Font.
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3. From the Font style list, choose Bold.
4. From the Font color list, choose Red.

Note: If you are not sure which color is red, place your mouse over each color without clicking, and its name
will pop up. Choose the color that says "Red."

5. Click OK.

Option 2
1. Select the tag.

2. Click on the Bold Toolbar button.
3. Click on the arrow beside the Font Color Toolbar button.
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4. Select the third color in the first column.

Word 2007
1. Select the tag.

2. Click on the Bold Toolbar button.
3. Click on the arrow beside the Font Color Toolbar button.

4. Select the second standard color.

Tag Identification

Tags Setup

Creating and Applying Microsoft Word Styles

tag_identification.htm
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To format your tags to use a Microsoft Word style, first need to create a new style. Several methods for creating a
style are shown below.

Word 2003
1. From the Format menu, choose Style.

2. Click on the "New Style ..." button.
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3. Type the name of the style exactly as you have (or will) type it in the Tags Setup for RMTrak (for example,
RMTrak Tags).

4. Make sure the Style Type is "Character".
5. To assign its font properties, click Format then choose Font.

Assign font properties you wish to apply to the tags. If you want the tags to be invisible, select the Hidden
check box in the Effects section. When you are finished, click OK.

6. Click OK.
The style will appear in the Style drop-down list (to the left of the Font drop-down list).

Word 2007

1.
2. Click on the Style toolbar Dialog Box Launcher.
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3. Click on the New Style button.
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4. Type the name of the style exactly as you have (or will) type it in the Tags Setup for RMTrak (for example,
RMTrak Tags).

5. Make sure the Style Type is "Character".
6. To assign its font properties, click Format then choose Font.

Assign font properties you wish to apply to the tags. If you want the tags to be invisible, select the Hidden
check box in the Effects section. When you are finished, click OK.

7. Click OK.
The style will appear in the Style drop-down list (to the left of the Font drop-down list).

Once you have created a style, you can apply it to your tag at any time by highlighting the tag, then selecting the
style from the Style drop-down list.

Tag Identification

Tags Setup

Turning Hidden Text Off and On

If you create a Microsoft Word style that is invisible (or have formatted paragraph text to be hidden, you can enable
or disable your ability to see the hidden text at any time.

Word 2003

tag_identification.htm
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To show the hidden text, click on the Hidden Text Button. To hide the hidden text, click on the Hidden Text

Button again. When the button is "highlighted"  the hidden text will be visible. When the button is not

"highlighted", , the hidden text will not be visible.

Word 2007

To show the hidden text, click on the Hidden Text Button. To hide the hidden text, click on the Hidden Text

Button again. When the button is "highlighted"  the hidden text will be visible. When the button is not

"highlighted", , the hidden text will not be visible.

Creating and Applying Microsoft Word Styles

Carriage Returns

If your document uses a paragraph mark, ¶, (created by pressing ENTER) as a tag terminator, you will need to use
soft returns, ,  (created by pressing SHIFT + ENTER) to create line breaks within the tags and requirements. To
see these paragraph symbols, you will need to make sure Microsoft Word has the paragraph marks option turned
on.

 

Requirement Terminators

Requirements Setup

Paragraph Marks Off and On

Turning Paragraph Marks Off and On

If you use paragraph marks (¶) as tag terminatorsin your document, you will need to be able to see them: In
Microsoft Word, from the Tools menu, choose Options. Click the View tab. In the Formatting Marks section, check
the Paragraph Marks check box. Click OK.

A paragraph mark will appear as a ¶, a soft returns will appear as a , and spaces will appear as dots.

 

Carriage Returns

Requirement Identification

Requirements Setup
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Microsoft Word Macros

When installing RMTrak, the following macros will also be installed:

Tag2Text Converts selected text to non-red/non-bold text.

Text2Tag Converts selected text to red/bold text.

TagIndex Puts a tag index at the cursor location. If a tag index
already exists in the document, Microsoft Word asks if
you want to delete it.

TagMatrix Puts a tag matrix at the cursor location. If a tag matrix
already exists in the document, Microsoft Word asks if
you want to delete it.

TagInsert Displays a dialog box and then inserts a tag at the
cursor location.

TagInsertParent Displays a dialog box and then inserts a parent tag at
the cursor location.

TagInsertAttribute Displays a dialog box and then inserts a attribute at the
cursor location.

TagRenumber Renumbers all of the tags in a document so that they
are sequential.

TagAbout Displays a dialog box with information about the tag
macros.

TagNextAvailable Searches the document and reports the next available
tag.

TagDuplicateCheck Checks the document for duplicate tags.

TagAutoTag Automatically tag each sentence in a document
containing the word "shall".

TagOptions Displays a dialog box that allows the user specify tag
identification and requirement termination settings.

To use these macros:

1.From the Microsoft Word Tools menu, choose Macro, then Macros. (A shortcut for these steps is to press ALT
+F8). The Macros window will appear.

2.Choose a macro from the list and click Run.

Working with Microsoft Word

Tags Menu

Tag Index

The Tag Index Macro produces an index of all of the Child Tags in the document. The index can be useful when
working with large documents that do not have consecutively numbered Child Tags. By using the Tag Index, a
reader can quickly find a Child Tag within the document. This index is placed at the current cursor location.

For example, if a document contained the following tags.

SRS:1 This requirement is on page 1. [PRD:1]

SRS:2 This requirement is on page 2. [PRD:3]

SRS:33 This requirement is on page 1. [PRD:5]

........................................ Page Break ..............................................

working_with_word.htm
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SRS:3 This requirement is on page 2. [PRD:1]

SRS:4 This requirement is on page 2. [PRD:2]

Then the Tag Index would appear as follows.

SRS:11
SRS:21
SRS:32
SRS:42
SRS:331

 

Tag Options

Tag Insert

The TagInsert Macro prompts the user to select a Tag and then inserts the Tag into the document. The tag is
inserted using the currently defined Tag Identification Method. To use the macro

Place the cursor where you want the tag inserted.

Select the Tag->Insert Tag menu item.

Enter the appropriate tag. Each time a tag is inserted, RMTrak increments the tag numbers. Therefore, if the tag is
already correct then there is no need to change it.

Click the OK button or press Enter.

 

Tag Options

Tag Insert Attribute

The TagInsertAttribute macro is used to insert a Attribute into the document. The new attribute is inserted at the
current cursor location using the current Tag Identification Method.

Place the cursor where you want the tag inserted.

Select the Tag->Insert Attribute menu item.
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Enter the attribute text.

Click the OK button or press Enter.

If you do not include the enclosing braces in the attribute text, then RMTrak will automatically add them.

 

Tag Options

Tag Insert Parent

The TagInsertParent macro opens a dialog and inserts the specified Parent Tag into the document. The Parent
Tag is inserted at the current cursor location using the currently defined Tag Identification method.

Place the cursor where you want the tag inserted.

Select the Tag->Insert Parent menu item.

Enter the attribute text.

Click the OK button or press Enter.

If you do not include the enclosing brackets in the text, then RMTrak will automatically add them.

 

Tag Options

Tag Matrix

The Tag Matrix Macro creates a matrix showing the parent-child relationships in a document. The First column
contains the parent tag and the second column contains the Child Tags. The matrix is placed at the current cursor
location.
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For example, if a document contained the following tags.

SRS:1 This requirement is on page 1. [PRD:1]

SRS:2 This requirement is on page 2. [PRD:3]

SRS:33 This requirement is on page 1. [PRD:5]

........................................ Page Break ..............................................

SRS:3 This requirement is on page 2. [PRD:1]

SRS:4 This requirement is on page 2. [PRD:2]

Then the Tag Matrix would be as follows:

PRD:1 SRS:1

PRD:1 SRS:3

PRD:2 SRS:4

PRD:3 SRS:2

PRD:5 SRS:33

 

Tag Options

Tag Options

The TagOptions macro allows you to configure how RMTrak identifies Tags and Requirements in the current
document. This macro performs a similar function to the application's Setup->Options menu item. When the
macro is run it brings up a dialog. The Tags Tab allows you to specify whether tags will be identified as Red/Bold
Text or using a particular style. See Tag Identification for a discussion of the two methods.

The Requirements Tab allows you to specify whether requirement text is terminated by a Paragraph Mark or by a
user defined special character. See Requirement Termination for a discussion of the two methods.



90 / 111

Tag Renumber

The TagRenumber macro renumbers all of the child tags in a document. This macro should not be used
after links have been established back to the document. Doing so may break the links.

 

Tag Options

Tag Find Next Available

The TagNextAvailable Macro reports the next available tag for the document. This macro will search through the
document and find the largest numbered tag. It will then report one greater than this number. This macro only
works if the tags within a document are all the same format. If the tags are different format then the macro will
report the next number for the last tag found. For example, given the tags below, the next available number is
SRS:34

SRS:1 This requirement is on page 1 [PRD:1].

SRS:2 This requirement is on page 2 [PRD:3].

SRS:33 This requirement is on page 1 [PRD:5].

SRS:3 This requirement is on page 2 [PRD:1].

SRS:4 This requirement is on page 2 [PRD:2].

For the following example the next available number is SRS:UI:5.

SRS:UI:1 This requirement is on page 1 [PRD:1].

SRS:UI:2 This requirement is on page 2 [PRD:3].

SRS:RF:33 This requirement is on page 1 [PRD:5].

SRS:UI:3 This requirement is on page 2 [PRD:1].
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SRS:UI:4 This requirement is on page 2 [PRD:2].

 

Tag Options

Tag Duplicate Check

The TagDuplicateCheck macro scans the document looking for duplicate tags. If duplicate tags are found the
macro displays the page numbers on which the first and subsequent tag can be found.

Click the "OK" button to continue searching for duplicate tags. Press the cancel button to stop checking.

Tag Options

Tag Auto Identify

The TagAutoTag macros automatically tags each sentence in a document. When the macro is run, it prompts for
the tag prefix.

Each sentence in the document that contains the word "shall" will be tagged with this prefix followed by a number.
The number will be incremented with each tag added. The format and style of the tag will be determined by the
current settings.

Tag Options

Tag Menu

The first time that you run RMTrak, RMTrak copies a file into the Microsoft Word Startup directory. In adition to the 
Tag Macros, this file creates a new Micrsoft Word Menu that allows quick acces to the most frequently used
Macros. How you access this menu depends upon which version of Microsoft Word you are using.

·Word 2003
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·Word 2007
For Word 2007 the tag menu is found on the Add-Ins Ribbon.

The Tag Menu provides quick access to the following Tag Macros.

Insert Tag Displays a dialog box and then inserts a tag at the cursor location.

Insert Parent Displays a dialog box and then inserts a parent tag at the cursor location.

Insert Attribute Displays a dialog box and then inserts a attribute at the cursor location.

Insert Matrix Puts a tag matrix at the cursor location. If a tag matrix already exists in the document,
Microsoft Word asks if you want to delete it.

Insert Index Puts a tag index at the cursor location. If a tag index already exists in the document,
Microsoft Word asks if you want to delete it.

Renumber Renumbers all of the tags in a document so that they are sequential.

Duplicate Check Checks the document for duplicate tags.

Find Next Number Searches the document and reports the next available tag.

Auto Tag Automatically tag each sentence in a document containing the word "shall".

Options Displays a dialog box that allows the user specify tag identification and requirement
termination settings.

Help Open a help window.

About Displays a dialog box with information about the tag macros.

 

Working with Microsoft Word

Hot Keys

A Hot Key can be assigned to any of the Tag Macros. This is not done during installation, because assigning by an
automated approach risks corrupting existing key assignments. To assign a Hot Key, in the Microsoft Word
document:

1)Click on the Tools->Customize Menu Item.

2)Click on the Options Tab.

macro_insert.tag.htm
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3)Click on the "Keyboard..." Button.

4)In the list of categories, select "Macros" and in the list of Commands select the desired Tag Macro. In the
example below, we have chosen the Text2Tag Macro.
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5)Click in the "Press new shortcut key" edit box.

6)Press the desired shortcut key combination.

7)Click the "Assign" button.

8)Click the "Close" button on the Customize Keyboard Dialog.

9)Click the "Close" button on the Customize Dialog.

Working with Microsoft Access

RMTrak stores all of the information that it extracts from your documents in a database. The database has the
extension ".TRA", but it is just a Microsoft JET Database. The database can be opened and manipulated with any
program that can access a JET Database. One common example would be Microsoft Access.

Warning: Although the RMTrak database can be opened by other applications
doing so may corrupt the database. In this sutuation, the database should be
backed up regularly.

Database Schema

The .tra database RMTrak uses contains tables of information. These tables are only available through SQL
queries and are considered to be "behind the scenes" of RMTrak's program interface. Many users will not need to
bother with the database schema, but advanced users may want to know about it so they can perform their own
SQL queries or access the database from within Microsoft Access.

The following chart shows the relationship of some of RMTrak's tables. For more information, please open the
database in Microsoft Access.
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For more information on the database schema, please see the How To Write a Custom Report White Paper.

SQL Syntax

SQL Querying

Working with Microsoft Access

SQL Queries

RMTrak stores its information in a database then retrieves the information using SQL (Structured Query Language)
queries.

If you are familiar with SQL, you can create your own SQL queries by clicking the Views menu, choosing New, then
selecting the SQL tab. You can type your SQL commands in this window. For information on SQL syntax, see the
SQL Syntax topic.
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View Dialog showing SQL tab with SQL command

 

Database Schema

SQL Syntax

SQL Syntax

RMTrak uses SQL (Structured Query Language) queries to retrieve records from the database.

The form of the query should be as follows:

SELECT fieldlist

FROM tablename

WHERE searchconditions

ORDER BY fieldlist ;

The clauses are described below.

SELECT Clause

The SELECT clause specifies which database fields you want to retrieve. It has the syntax:

[table name].[field name]

[table name].[field name] as alias

FROM Clause

The FROM clause specifies which table(s) the records should be drawn from. The simplest query specifies a
single table.

For example, to see all of the documents in the database, the syntax would be:

SELECT * FROM Documents;

One of the most powerful characteristics of relational databases is the ability to join two or more tables together to
create a new table containing information from both tables. Tables are joined according to relations between fields
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in the tables. The basic syntax for a join is:

FROM table1 jointype table2 ON table1.field = table2.field

The result of a join is dependent in the type of join performed.

INNER JOINRecords from both tables are included in the join only when a specified field in the first table matches
the specified field in the second table.

LEFT JOINAll records in the first table are included in the join, together with records from the second table where
the specified fields match.

RIGHT JOIN All records from the second table are included in the join, together with records from the first table
where the specified fields match.

For example, to select all requirements that were allocated to the 196SW, the syntax would be:

SELECT Requirements.* FROM Requirements INNER JOIN [Developer] ON Requirement.TagId = [Developer]
.TagId WHERE [Developer].Value = "196SW";

Joins can be nested using this syntax:

FROM table1 INNER JOIN (table2 INNER JOIN table3 ON table2.field = table3.field) ON table2.field = table1.field

WHERE Clause

The WHERE clause specifies which records from the tables listed in the FROM clause are included in the results of
the query. If a WHERE clause is not specified, then all rows are returned. WHERE is optional, but when included,
follows FROM.

For example, you can retrieve all requirements in a particular document using:

WHERE DocNumber = 30812

Or you can retrieve all requirements in multiple documents using:

WHERE ((DocNumber = 30812) OR (DocNumber = 30813))

Use the following operator to build the WHERE expression.

  AND Logical And

  OR Logical Or

  NOT Logical Negation

  = Equal

  <> Not equal

  < Less Than

  <= Less Than or Equal

  > Greater Than

  >= Greater Than or Equal

 

Strings must be enclosed within quotes. Dates must be enclosed within #s.

For example, to find all changes occurring after March 6, 1996 use the syntax:

WHERE [Change Date] > #3/6/96#

ORDER BY Clause

The ORDER BY clause determines the sort order of the records retrieved by the query. In the ORDER BY clause, the
query specifies the column or columns to be used as the ordering key and then specifying whether records are to
appear in ascending or descending order of magnitude. The following example returns all tags in alphabetical
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order.

SELECT [Requirements].[Tag] FROM [Requirements] ORDER BY Tag ASC;

In this example, the ASC (for "ascending order") is optional?the default sort order is ascending. If you want to sort
the fields in descending order use the DESC keyword.

You can include additional fields in the ORDER BY clause. Records are sorted first by the first field listed after
ORDER BY. Records that have equal values in that field are then sorted by the value in the second field listed, and
so on.

For example, to sort changes by type and by date, use this syntax:

SELECT * FROM [Changes] ORDER BY [Changes].[ChangeType], [Changes].[ChangeDate];

 

SQL Querying

Troubleshooting

RMTrak might occasionally display error messages. These messages were designed to help you use RMTrak
correctly and efficiently. If you do not understand an error message, please use the list below to learn more about
them.

Attribute Name Is Too Long

Attribute Rule Is Too Long

Boolean Attributes Have No Rules

Database Out of Date

Document Out of Date

Duplicate Tag

Enum Attribute Must Have a Rule

Filename Is Too Long

Internal Error

Invalid RTF File

Invalid Document Number

Invalid Document Revision

Title Is Too Long

RMTrak Out of Date

RMTrak32.DLL Is Missing

RMTrak32.DLL Is Too New

RMTrak32.DLL Is Too Old

Unable to Locate ReqPro System Database

Unable to Open Document

Unable to Open File

Unable to Save

If RMTrak behaves inconsistently without displaying an error message, try restarting your computer. If the problems
persist, please contact RMTrak Support. Additionally, please check the RMTrak web site for updates or additions to
RMTrak, its help files, and its tutorial: http://www.RMTrak.com

Attribute Name is Too Long

Problem: You receive the error message "Attribute Name is Too Long."

Explanation: The attribute name you are specifying is too long to fit in the database. Attribute names must be less
than 50 characters.

working_with_access.htm
document_out_of_date.htm
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Resolution: To fix the problem, shorten the name to less than 50 characters.

Attributes

Attribute Edit Dialog

Defining Attributes

Attributes' Data Types and Rules Syntax

Attribute Rule is Too Long

Problem: You receive the error message "Attribute Rule Is Too Long."

Explanation: The rule you are specifying is too long to fit in the database. Attributes rules must be less than 200
characters.

Resolution: To fix the problem, shorten the rule to less than 200 characters.

 

Attributes

Attribute Edit Dialog

Defining Attributes

Attributes' Data Types and Rules Syntax

Attribute Value Truncated

Problem: Attribute Value Truncated.

Description: A String Attribute can have a maximum of 255 characters. The value being assigned to this attribute
exceeds that length. RMTrak has truncated the value.

Resolution: Reduce the length of value to less than 256 characters.

Boolean Attribute With Rule

Problem: You receive the error message "Boolean Attributes Have No Rules."

Explanation: You are specifying a rule for a Boolean attribute; RMTrak does not permit this.

Resolution: To fix the problem, change the Boolean attribute to either Yes or No

 

Attributes

Attribute Edit Dialog

Defining Attributes

Attributes' Data Types and Rules Syntax

attrib_edit_dialog.htm
attrib_definition.htm
attrib_edit_dialog.htm
attrib_definition.htm
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Attribute In Use

Problem: Unable to delete "xxxx"attribute because it is still in inuse.

Description: The attribute that you are trying to delete is currently being used in the project.

Resolution: Remove the attribute from all requirements in the project and then refresh the changed documents.

Database is Corrupted

Problem: RMTrak reports that the database is corrupt Corrupt Database

Description: The database is missing key tables. This is probably caused by opening the database in another
application and modifying the tables.

Resolution: The database will need to be recreated.

Database is Out of Date

Problem: You receive the error message "Database Out of Date."

Explanation: The database you are trying to open has a format older than expected by the installed revision of
RMTrak.

Resolution: When you receive this message, if you click Yes, RMTrak will attempt to upgrade the database format.
If you click No, you will be unable to use the existing database with the installed revision of RMTrak

Creating Databases

TRACER32.DLL is Too New

Problem: You receive the error message "RMTRAK32.DLL Is Too New" or "Tracer32.DLL Is Too New."

Explanation: The Dynamic Link Library file is too new to be used with the version of RMTrak that you are trying to
run. Installing an older version of RMTrak after installing a new version might have caused this.

Resolution: To fix the problem, attempt to uninstall and reinstall RMTrak.

Document Contains No Tags

Problem: Document Contains No Tags

Description: When RMTrak imported the document no tags were found.

Resolution:  Either the project is configured to look for a different tag style or the document does not actually
contain any tags. if it is the former then the project's tag identification method should be modified and the
document refreshed. 

Document Number is Missing

Problem: Document Number Must Be Specified.
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Description: You are trying to import a document into a database that uses Document Numbers, but RMTrak is
unable to determine the Document Number.

Resolution:  If you are storing Document Numbers in MS-Word properties then the document does not have this
property defined or its value is blank. If the document number is part of the file name, then the regular expression
used to specify the Document Number portion of the filename is incorrect or the filename is incorrect.

Document Number is Too Long

Problem: Maximum Document Number is 50 characters.

Description: The maximum number of characters in a document number is 50. 

Resolution: If you document number is longer than 50 character, you will have to shorten it.

Document Revision is Missing

Problem: Document Revision Must Be Specified.

Description: You are trying to import a document into a database that uses Document Revisions, but
RMTrak is unable to determine the Document Revision. 

Resolution: If you are storing Document Revisions in MS-Word properties then the document does not have
this property defined or its value is blank. If the document revision is part of the file name, then the regular
expression used to specify the Document Revision portion of the filename is incorrect or the filename is
incorrect.

Duplicate Tag

Problem: You receive the error message "Duplicate Tag."

Explanation: You have the same requirement listed in more than one document.

Resolution: Remember that RMTrak recognizes requirements from their tags. Although the requirement text might
appear unique, you might have accidentally duplicated the requirement's tags in more than one requirement. To fix
the problem, find the occurrence of duplicate tags in your documents; you will need to rename one of the tags then
refresh the document in RMTrak.

 

Overview of Tagging

Enum Attribute Without a Rule

Problem: You receive the error message "Attribute Must Have a Rule."

Explanation: You have tried to create an attribute and did not specify a rule; RMTrak does not permit this. The rule
identifies what values are legal for attribute. The rule is a semicolon-separated list of values. For example,
"SW;HW;QA;MECH".

Resolution: To fix the problem, be sure to specify a rule when creating Enum attributes.

Attributes' Data Types and Rules Syntax

Filename is Too Long

Problem: You receive the error message "Filename Is Too Long."
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Explanation: The file location (file path) you are specifying is too long to fit in the database. Paths must be less
than 250 characters.

Resolution: To fix the problem, try shortening the path to the file's location so there are fewer subdirectories

Internal Error

Problem: You receive the error message "Internal Error."

Explanation: An unexpected error has occurred within the program.

Resolution: Please Contact RMTrak Support for analysis.

Invalid Attribute

Problem: You receive the error message "XXXX is an invalid attribute" while trying to import a document

Explanation: RMTrak did not recognize the attribute name while importing a document. This is due to either a typo
or an undefined document type.

Resolution: if the problem is a typo, correct the document and refresh. If the problem is an undefined document
type, define a new attribute.

Invalid Character

Problem: Requirement "xxxx" contains an invalid character.

Description: An invalid character was found with a tag. Tags may not contain spaces.

Example:

PRD:1 The box shall be blue ]CRD:1¶

PRD:*1 The box shall be blue }TEST=ME}¶

Invalid Boolean Value

Problem: "XXX" is an invalid boolean.

Explanation: The value "XXX" is not a valid boolean value. Boolean values are case insensitive and can be any one
of the following values: "T", "TRUE", "F", or "FALSE".

Invalid Date Value

Problem: "XXX" is an invalid date.

Explanation: The value "XXX" is not a valid date. RMTrak supports three different date formats. 

o M/D/Y - This is the standard date format for the United States. This format is selected by the operating
system's Date Format.

o D/M/Y - This is the standard date format for countries other than the United Status. The format is
selecetd by the operating system's Date Format.

o YYYY-MM-DD - This the ISO-8601 Date Format. It is always available regardless of the operating
system's Date Format. 

The operating system's current Date Format can be viewed by going to the Control Panel and clicking Regional
and Language Options.
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Invalid Document Number

Problem: You receive the error message "Invalid Document Number" while trying to import a document

Explanation: You have RMTrak's Documents Setup configured to recognize document number from the
document's filename or document properties, but you are importing a document that does have document
number.

Resolution: To fix the problem,

Disable Document Number by changing the Document Number section of RMTrak's Documents Setup to None.

If you are retrieving Document Number from the filename, then you can change the filename of the document.

If you are retrieving Document Number from a Microsoft Word Property, then you can add the property to the
document or fix its value.

 

Putting Document Information In Filenames

Putting Document Information In Document Properties

Invalid Document Revision

Problem: You receive the error message "Invalid Document Revision" while trying to import a document using the
New Document dialog

Explanation: You have RMTrak's Documents Setup configured to recognize document revision from the
document's filename or document properties, but you are importing a document that does not have a valid integer
(1, 2, 3, etc.) or real numbers with up to two places to the right of the decimal (1.35, 2.63, 9.65, etc.) located in its
filename or document properties.

Resolution: To fix the problem, change the Document Number section of RMTrak's Documents Setup to None,
then re-import the document.

 

Putting Document Information In Filenames

Putting Document Information In Document Properties

Invalid Enumeration Value

Problem: "XXX" is an invalid enumerated value.

Explanation: The value "XXX" is not a valid value for the enumerated type. 

Invalid Floating Point Value

Problem: "XXX" is an invalid floating point number.

Explanation: The value "XXX" is not a valid floating point number.

Example:

"A"

"-12G10"
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Invalid Integer Value

Problem: "XXX" is an invalid integer.

Explanation: The value "XXX" is not a valid integer. Valid integers contains the digits 0-9, are greater than ?32768
and less than 32767.

Example:

"A"

"-6555"

"12E1"

Invalid Value

Problem: "XXX" is an invalid value for "YYY"

Explanation: The value "XXX" is not a valid value for the attribute "YYY". The reason for this depends on the type of
attribute.

o Date

o Integer

o Floating Point

o Enumeration

o Boolean

Invalid RTF File

Problem: You receive the error message "Invalid RTF File."

Explanation: RMTrak is attempting to open an invalid RTF file.

Resolution: To fix the problem, make sure the RTF is a valid RTF file.

Tag Rejected By Tag Filter

Problem: Requirement "xxxx" has been rejected by tag filter.

Description: The requirement was not imported into the database because it did not match the Tag Filter. 

Resolution: If the requirement was not supposed to be imported then this warning can be ignore. If the
requirement should have been imported than either the requirement tag is incorrect and should be fixed or the tag
filter is incorrect.

Tag Filter

Requirement Truncated

Problem: Requirement "PRD:1" text has been truncated.

Description: The database can only store 5000 characters per requirement. Anything in excess of this is not
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stored.

RMTrak is Too Old

Problem: You receive the error message "RMTrak Out of Date."

Explanation: The version of the database that you are trying to open is newer than the version of RMTrak.

Resolution: To fix the problem, install a newer version of RMTrak.

Tag Menu is Missing

Problem: The Tags Menu is not available in MS-Word

Description: There are three possible causes for this problem.

Solution 1 - TAGS.DOT Not Copied to MS-Word Startup Directory

Normally RMTrak copies TAGS.DOT to the MS-Word Startup Directory the first time that it opens. If this does not
happen, copy TAGS.DOT from the RMTrak Installation Directory to the MS-Word Startup Directory. Use the following
procedure to determine the location of the MS-Word Startup Directory.

1) Open MS-Word.

2) Click on the Tools->Options Menu

3) Click on the File Locations Tab.



106 / 111

4) Double Click on the Startup Line.
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The MS-Word Startup Directory is shown in the "Folder name" control. Note that the directory name is usually very
long and you may have to scroll back and forth to see the entire thing.

Solution 2 - MS-Word Still Loaded in Memory

The menu gets loaded when MS-Word starts up. Some of the newer versions of MS-Word do not unload from
memory when they are shutdown. Use the following procedure to tell if this is the problem.

1) Right click on the Windows Taskbar.

2) Left click on the Task Manager Menu Item.

3) Click the Processes Tab.

4) To sort the entries, click on the Image Name Column Header.

If WINWORD.EXE is listed then MS-Word is loaded and the Tag Menus will not load. The simplest solution is to
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restart your computer.

Solution 3 - MS-Word Security Prevents the Menu From Loading

To solve this problem, all you need to do is run the Macro that creates the menu.

Open MS-Word

1) Select the Tools->Macros->Macros Menu or press Alt-F8.

2) Select the AutoExec Macro

3) Click the Run Button

Title is Too Long

Problem: You receive the error message "Title Is Too Long."

Explanation: The document title you are specifying is too long to fit in the database. Document titles must be less
than 50 characters.

Resolution: To fix the problem, shorten the title so it is less than 50 characters.

TRACER32.DLL is Missing

Problem: You receive the error message "RMTRAK32.DLL Is Missing" or "Tracer32.DLL Is Missing."

Explanation: The Dynamic Link Library file is not present on your system. This might be the due to problems with
the installation program.

Resolution: To fix the problem, try reinstalling RMTrak.

Tracer32.DLL is Too Old

Problem: You receive the error message "RMTRAK32.DLL Is Too Old" or "Tracer32.DLL Is Too Old."

Explanation: The Dynamic Link Library file is too old to be used with the version of RMTrak that you are trying to run.
This might have been caused by a faulty installation.
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Resolution: To fix the problem, delete the .dll file from you Microsoft Window's system directory and reinstall
RMTrak.

Unable to Find Req Pro

Problem: You receive the error message "Unable to Locate ReqPro System Database" or "Requisite Pro Not
Found."

Explanation: For RMTrak to import a Requisite Pro Database, the "RQPRODB.MDA" file must be located on your
computer. Normally this file is located in the Rational RequisitePro installation directory. If you are getting this
message, you probably either do not have Rational RequisitePro installed on your computer or you do not have a
compatible version of Rational RequisitePro.

Resolution: To fix the problem, check to be sure you have Rational RequisitePro installed on your computer.

 

Importing a Rational RequisitePro Database

Unable to Open Documeny

 Problem: You receive the error message "Unable to Open Document."

Explanation: RMTrak is unable to open the document. This might be because the document has changed file
locations.

Resolution: To fix the problem, within the main Documents Window, select the document, click Properties, and
then browse to find the correct file location of the document.

 

Opening Documents

Unable to Open File

Problem: You receive the error message "Unable to Open File."

Explanation: RMTrak is unable to open a file. This is might be because the file has changed locations or has been
deleted.

Resolution: If the file is no longer needed, you may delete it from the database. If the file is needed, change its
location properties: Within the main Documents Window, select the document, click Properties then browse to find
the correct file location of the document.

Opening Documents

Unable to Save File

Problem: You receive the error message "Unable to Save."

Explanation: RMTrak is unable to save a temporary file. This might be because your TEMP folder is full.

Resolution: Locate the TEMP folder on your hard drive and delete the contents.
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Unterminated Brace

Problem: Requirement "PRD:1" has a non-red character between curly brackets.

Description: A non-tag characters was found between curly brackets or an ending curly bracket was not found. It is
assumed that this is caused by a missing bracket, but it could also be caused by incorrect formatting.

Example:

PRD:1 The box shall be blue {TEST=ME¶

PRD:1 The box shall be blue {TESTER=ME}¶

Unterminated Bracket

Problem: Requirement "PRD:1" has a non-red character between brackets.

Description: A non-tag characters was found between brackets or an ending bracket was not found. This is
probably caused by a missing bracket, but it could also be caused by incorrect formatting.

Examples:

PRD:1 The box shall be blue [CRD:1¶

PRD:1 The box shall be blue [CRD:1.2]¶

Expired License

Problem: License file expired on MM/DD/YYYY.

Explanation: The license file has expired. 

Resolution: If this was an evaluation license you may request a extension or purchase a a permanent lince. If it
was a purchased license, this should not have happened. Please contact RMTrak Support.

Invalid License

Problem: "XXX" is not a valid license.

Explanation: The file "XXX" is not a valid license file.

Resolution: Use the License Manager. to install a different license file. If your license file has become corrupted
you may download a copy from the RMTrak Website.

License Version

Problem: License file is only valid for version X and earlier.

Explanation: The installed license file is only valid for version X and earlier.

Resolution: If you have purchased a license file for a newer version of RMTrak you should install it using the
License Manager.

RMTrak is Out Of Date

Problem: RMTrak is out of date. You must upgrade RMTrak before proceeding.

Explanation: The version of the databse that you are trying to open is newer than supported by the installed version
of RMTrak.

Resolution: In order to open the database, you will need to install a newer version of RMTrak.
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Attribute is Persistent

Problem: "xxxx" is a persistent attribute and can not be updated from a document.

Explanation: The attribute "xxxx" is persistent and was found in within a document. Persistent attribute are set
through the RMTrak application and not from a document.

Resolution: Remove the attribute from the document or make the attribute non-persistent.
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